EASYCATALOG
FOR ADOBE® INDESIGN®

RELEASE NOTES
65BIT SOFTWARE LTD

These Release Notes detail the changes made to EasyCatalog since the previous version and may include details of new
functionality that is not yet included in the main EasyCatalog User Guide.
Maintenance releases of EasyCatalog will also include a number of bug fixes, so it is a good idea to check that you’re always
running the latest version of EasyCatalog using the ‘Check for Updates’ button on the ‘About EasyCatalog’ dialog.
Release Notes for previous versions not listed in this document can be found here:
http://www.65bit.com/downloads/easycatalog/files/Previous Release Notes.pdf

Upgrading from Previous Versions
Installing This Update

The latest version of EasyCatalog can be installed using the installer that can be downloaded from our web site:
http://www.65bit.com/downloads/downloadpre.shtm

!

AS WITH ANY SOFTWARE UPGRADE, ALWAYS BACKUP YOUR EASYCATALOG WORKSPACE
FOLDER AND DOCUMENTS PRIOR TO INSTALLING THE LATEST VERSION.

Version 10.0.3
This version is only available for Macintosh as it contains a fix specifically for this platform.

Bug Fixes
The following bugs have been fixed in this release of EasyCatalog. For clarity, the bug reports listed below show the original
problem as reported. It is often not possible to detail the fix for each issue as they involve internal changes to EasyCatalog.

EasyCatalog

Fixes slow panel drawing on Macintosh when running under OS X Yosemite. The slow performance was caused by the bold
font used in panel headers and by panel group rows. This interim release does not use the bold font. This affects CC 2014 on
the Mac; CC9 is unaffected.

Version 6.4.2/9.2.2/10.0.2
This version is only available for Macintosh as it contains a fix specifically for this platform.

Bug Fixes
The following bugs have been fixed in this release of EasyCatalog. For clarity, the bug reports listed below show the original
problem as reported. It is often not possible to detail the fix for each issue as they involve internal changes to EasyCatalog.

EasyCatalog

• Fixed activation error -2003 error that occurs after
upgraing OS X Mavericks.
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About This Document

8 July 2014

Enhancements
EasyCatalog

• CC version will now activate using CC 2014 serial
numbers.
[1153]

Bug Fixes
The following bugs have been fixed in this release of EasyCatalog. For clarity, the bug reports listed below show the original
problem as reported. It is often not possible to detail the fix for each issue as they involve internal changes to EasyCatalog.

EasyCatalog

• ‘Preserve White Space Changes’ is being applied when
populating Field Specifiers. This could cause unexpected
characters to appear in populated Field Specifiers.

[1146]

• EasyCatalog Lite user interface showing string keys when
running on Spanish system. 
[1142]
• French translation missing for ‘EasyCatalog Pagination
Rules’ menu option
[1150]
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Version 6.4.1/9.2.1/10.0.1

23 June 2014

Enhancements
EasyCatalog

• Added a new option to preserve the scale and offset
of images on ‘Update Document’. If an image path or
filename changes, ‘Update Document’ will now re-link to
the new image path rather than completely re-importing
the images. This will only happen when the ‘Preserve
Size and Position on Update’ check box is set in Field
Options.
[1105]

• Added support for Adobe InDesign CC 2014.

• Support has been included for directly importing
Microsoft Excel files. A new option is available on the
File > New > EasyCatalog Panels menu (“New Excel
Data Source”). NOTE: Using the “Update Data Source”
menu option is supported, but a new spreadsheet will
be output. Therefore, if your Excel document contains
multiple sheets, or formulas are used to calculate some
of the values in the sheet you’re working with, these will
be lost on output. 
[1030]

• Added a new custom field command to retrieve
environmental information:
Name

• Added ‘Package’ button to the Data Source Information
dialog. This option will create a folder containing the data
source folder from the EasyCatalog Workspace folder, a
folder containing a configuration for each of the currentlyopen panels for the data source and the pagination library
(if one has been specified on the Paginate dialog).  [1085]
• Added a warning message to “Update Panel > With
Page Numbers” if the field being populated is not set to
alphanumeric. The field needs to be alphanumeric so that
page ranges, such as ‘1,2,5-9’ display correctly.  [1092]
• Added “New Panel” menu option to the “Record Viewer”
panel to open a regular EasyCatalog panel for the
currently-selected data source. 
[1065]

• Added error message that is displayed when the user
enters an EasyCatalog Lite serial number into the full
version of EasyCatalog. 
[1066]

version

The version number of EasyCatalog

buildno

The build number of EasyCatalog

username

The name of the user logged in to the
machine.

osversion

The version number of the operating system

platform

The platform
Windows)

being

used

(Macintosh/

decimalpt

The character being used as the decimal
separator

thousandssep

The character being used as the thousands
separator

applicationversion
workspacefolder

InDesign, InCopy or InDesign Server
The version number of the application
The location of the EasyCatalog workspace
folder.

e.g. retrieve the name of the current data source:

• Tags set up as character stylesheets now have on/off
properties like HTML, so for example:

ENV(‘datasourcename’)



<tag1>text<tag2>text</tag2>text<tag1>
At the end of </tag2> the style is reverted to <tag1>

The name of the current data source

applicationname

• The tool tip that’s displayed when hovering over a group
row in the panel now also shows the name of the field that
the panel is grouped by. 
[1083]

Value

datasourcename

[1109]

• Improved validation of serial number entry. Dashes are
automatically inserted if they are missing; the serial
number is truncated to the correct length and anything
other than a digit or A-Z is stripped.
[1110]

[1087]

• New
custom
field
command
‘GROUPGETNTHPOPULATEDFIELDNAME’.
This
command will accept a list of field names and return the
name of the n’th populated one. This function is useful for
creating ‘Column 1 Name’, ‘Column 1 Value’, ‘Column 2
Name’, ‘Column 2 Value’, etc data columns.

• Added new custom field command ‘FIELDNAME’ that
retrieves the name of the field that the command is being
used in.
[1112]

• Added support for specifying alternative glyphs for
numerically formatted fields. This can be specified in the
‘Custom’ numeric format:

This command accepts a group path, an index number
and a list of field names. It will look within the given
groupings and return the name of n’th populated column.

[1097]

[INTEGERGYPHS=ABCDEFGHIJ]
[DECIMALGYPHS=ABCDEFGHIJ]

This option can be used, for example, to specify
superscripted glyphs for the decimal part of a number
when using fonts that support these glyphs.
©2003 - 2013 65bit Software Ltd. All rights reserved.
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Version 6.4.0/9.2.0/10.0.0

If the resized table is too wide, EC will first resize the fillspace columns or, if there aren’t any, will resize the fit-tocontent columns within their limits so that the table fits.

[1088]

[1114]

• Added the ability to specify the local storage location
for images that are downloaded from a URL. The local
storage location is specified at the end of the URL
specification inside of { brackets }. In the following
example, the downloaded image will be stored using the
records ‘key’ field value with a .jpg extension:


EasyCatalog Pagination Module

http://www.65bit.com/general/logosmall2.gif{FIELDSTR(key).jpg}

• Added new ‘Direction of Flow’ option to the Paginate
dialog for Guide-based pagination: “Across, Down
(Aligned)”. When using collision detection this new option
will ensure that when moving down the page an item
will not be placed above the lowest point of any of the
already-paginated items. 
[1126]

[1121]

• A comma-separated UTF-8 data file of the panel’s
contents can be exported by holding down the Shift key
whilst selecting Reports > Panel.
[1129]

• Added new option to the ‘Table > Cell Options’ dialog to
specify the position index of the record that should be
used to populate the cell. 
[1106]

• After importing an image EasyCatalog now calls a
script called “PostImageImport.jsx” in the data source’s
“Assets” folder. This can be used for post processing of
the image import, such as applying a clipping path not
supported though the EasyCatalog User Interface.
// Sample script to change the clipping path to detect edges
// These can be used to extract the field name and content of the
// image field:
// alert(app.scriptArgs.getValue(“field”));
// alert(app.scriptArgs.getValue(“fieldContent”));
// Get the internal ID of the container from, passed in from
// EasyCatalog
var myID= Number(app.scriptArgs.getValue(“id”));

‘Across, Down’

‘Across, Down (Aligned)’

// Get the frame
var myFrame = app.activeDocument.pageItems.itemByID(myID)

Item number three has been
placed above the bottom
edge of the second item

Item number three has been
placed below the bottom
edge of the second item

// Get the image
var myImage = myFrame.allGraphics[0];

EasyCatalog Scripting Module

• “CALLSCRIPT” custom field function now targest a single
scripting engine called “ECExtendScript”. This enables
session variables to be created which will be stored until
InDesign quits.

// Set the clipping path
myImage.clippingPath.clippingType = ClippingPathType.DETECT_EDGES;



[1082]

• Added new custom field command ‘FRACTODEC’ that
will convert a string containing a fraction into a decimal
value:

#targetengine ECExtendScript



[1124]

• Added new function to retrieve field options:

FRACTODEC(‘1/2’,2)

var myEC = app.easycatalogObject;
var myDS1 = app.easycatalogObject.datasources.item(“SpareParts”);
var myVal = myDS1.getFieldOption(“pl_name_de”, “prefix”);

The command takes two parameters: the string containing
the fraction to convert and the precision (number of
decimal places).
[1121]



[1071]

• Added additional parameter to ‘adopt’ scripting call:
pass true as second parameter (default) to adopt all fields
across all layers; pass false to only adopt the fields from
the current (write) layer. 
[1126]

• Modification to table resizing: if the resized table is too
narrow, EC will now prioritize resizing fill-space columns
so that the fit-to-content columns will remain fitted. If
there are no fill-space columns then the fit-to-content
columns will be resized within their limits.
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The following bugs have been fixed in this release of EasyCatalog. For clarity, the bug reports listed below show the original
problem as reported. It is often not possible to detail the fix for each issue as they involve internal changes to EasyCatalog.

EasyCatalog

• Update Panel > With Page Numbers crashes when an
anchored object is overset.
[1094]

• The paragraph style applied to Imported Text during
import is lost on the first and last paragraphs. 
[1062]

• German translation for “A subset with this name already
exists. Overwrite?” missing the “Overwrite?” question.

[1095]

• Update Document > Selection updating too many fields
when there is a table selection or a text selection in a
table. 
[1070]

• Update Document > With Panel Selection sometimes
updates the entire document. This option no longer
updates Rule Sets.
[1098]

• The page number update is slow when using “Panel
Selection” on the “Update Panel > With Page Numbers”
dialog. 
[1072]

• User is unable to delete configurations due to a “File Not
Found” error.
[1103]

• Incorrect upgrade pricing shown when the user enters
a serial number for a previous version of EasyCatalog.

[1068]

• Tables that are set to “No Expansion” are not obeying the
“Merge Cells” attribute.
[1107]

• The page numbers for image boxes are not updated
when using “Panel Selection” on the “Update Panel >
With Page Numbers” dialog. 
[1073]

• “Paginate Into Text Flow” call not working from AppleScript
as the first parameter name contains slashes.
[1108]
• Custom field commands not processed in the “Missing
Image” path.
[1113]

• Inserting into a table not performing as stated in the
manual. When using the insert button, if the user has
a text insertion point in a table and multiple fields are
selected in the panel EasyCatalog should populate
adjacent cells with data from the panel selection.  [1074]

• Text wider than 850 pixels not drawn in the panel (CS6
Mac only).
[1115]

• DIV custom field now rounds to 7 decimal places by
default. An optional last parameter can be used to specify
the precision, or -1 to revert to behavior from previous
version.
[1116]

• No error message when attempting to populate a
Formatting Rule Set from a Relational Data Source.

[1075]
• Deactivation errors are not being reported.

• Some keyboard shortcuts that rely on a panel selection
are not working when using the Relational panel.
[1117]

[1076]

• Inserting page hyperlinks fails when the hyperlink legend
contains numbers.
[1077]

• Master-based Pagination is not working with master
pages that are derived from other master pages.
[1118]

• “Remove Blank Lines For Empty Fields” sometimes
removes paragraphs from the middle of fields if the field
breaks across multiple lines.
[1079]

• EasyCatalog crashing when resizing table columns.

• The table width is not being maintained correctly if fieldspecified column widths are used.
[1120]

• EasyCatalog crashes when updating rules if all boxes in
the Rule are deleted by actions.
[1080]

• Horizontal table population not maintaining width of table
if “Fixed” table width specified.
[1125]

• The current (applied) configuration is not always
highlighted in the panel.
This occurs when the
configuration contains saved subsets.
[1081]

• Cells in table header not merged when using horizontal
table population.
[1127]

• French translation of ‘An error occurred while applying
the Fitting attribute’ missing the actual error
[1128]

• Guide-based pagination can get stuck in an infinite loop
if:

• <matrixtable> not populating some footer cells. If a matrix
table has used header columns on the left or right, and
the footer cells are merged across the width of the table,
the footer will not be populated.
[1132]

• ‘collision detection’ is on

• ‘use next position if item doesn’t fit’ is on

• a master page is being applied from the data



• there is an obstruction on the first page of the
document.

• XML Data Provider outputting illegal characters during
“Update Data Source” such as ‘indent to here’
[1133]
• “Table Options” menu missing from Relational panel [1137]

[1084]

• Updating a Rule Set could remove all data from the
document if a filter using the ‘Is Empty’/’Is Not Empty’
operand was applied to the data and the field’s type
changed from alphanumeric to numeric.
[1089]
• HTTPS support missing (CS6 Mac only).

[1119]

• “Purge Deleted” changing the order of records in the data
source, which could adversely affect groups using the
‘Data Source Order’ setting
[1138]

[1093]
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Bug Fixes

• Unable to choose an InDesign library that is already open
on the “Paginate” dialog. User receives error about the
library being open in another application. 
[1135]

• Guide-based pagination can sometimes insert the wrong
item: when a header item is set to ‘keep with next’, and
the first item in the group is set to break to a new column/
row/page, instead of re-inserting the keep-with-next
header the item currently being paginated will be inserted
(twice). 
[1111]

• When using the “SQL” custom field command in a
relational data source, the command expects that all
data source names are fully qualified (i.e. {relational data
source name}/{child data source name}). This modification
allows the user to use just the child data source’s name.

[1134]

• Unhandled exception in ECPaginationUtils.cpp in line
247. 
[1102]

• Crash when dragging from a Relational panel (CC9
Windows only). 
[1130]
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• Guide-based Pagination crashing when using ‘keep with
next’ attribute which forces an item onto the next page
(InDesign Server only).
[1090]

5 December 2013

Enhancements
EasyCatalog

• Added new ‘Table Options’ dialog:]

• New paragraphs and soft returns are now displayed in
the panel using the pilcrow and ‘not sign’ glyphs.  [1030]

• Performance improvement to Guide-based pagination to
check for presence of updatable custom fields prior to
pagination. 
[1057]

• Added a new custom field function to load the contents
of a unicode file into a field.
LOADFILE("Macintosh HD:test.txt")



[960]

• Added new options to the “Update Panel > With Page
Positions” dialog to allow fields to be specified that will
be updated with the width and height of the placed field.

[1046]
• Custom field functions should now execute quicker and
retrieving data from other fields should also be faster.

[980]

• Added new keyboard shortcut to select the text between
the field markers at the current insertion point/selection
(“Select Text Between Markers”). 
[983]
• Added a new pop-up on the Custom Field Field Options
pane to specify when the contents of a custom field
should be updated - ‘Automatically’ will always keep
the content of the field up-to-date; ‘Manually’ will only
update the custom field when the “Update Selected
Custom Field(s)” menu option is used; ‘Update Only After
Synchronize’ will only update the field after a ‘Synchronize
with Data Source’ operation.
[1010]

• Width:

• Only applicable when columns are set to resize,
these settings determine the overall width of the table
(whether the width of the table should remain fixed, or
if it can resize within the specified parameters).

• Hold down the “Alt” key when selecting “Remove Field
Markers” to remove all zero width characters from the
document.
[1010]

• Column Resizing:

If a table needs to be resized after it has been populated
with data, this attribute specifies how each of the resizable
columns is adjusted.

• Added support for outputting the day of the week when
using Date/Time formatted fields.
[1023]

Attribute

• “Auto Pickup” keyboard shortcut will now process the
entire document if there is no selection.
[1025]
• ECPAGE URLs now support lists of pages, with separate
hyperlinks created for each numeric part of the URL:
e.g.

Evenly

Each column that is set to be ‘resizable’ will
be given an equal proportion of the available
space regardless of how much text they
contain. For example, if the table contains
10 columns and the table needs to expand
by 100pt each column will be adjusted by
10pt.

Proportionally,
based on content

Each resizable column will be given a
proportion of the available space based
on the amount of text they contain. For
example, if a 10-column table needs to
expand by 100pt, a column containing 100
characters will receive double the amount
of space that a column containing 50
characters will.

ECPAGE://1,3-10,12

The above URL will create four page-desintation
hyperlinks.
[1044]
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Version 6.3.0/9.1.0

• Expand:
Attribute

Usage

Vertically

The default method of table population,
one row will be created in the table for each
record in the source data.

Horizontally

One column in the data will be created
for each record in the data. If the table
prototype consists of two columns, the first
column will be assumed to be a ‘header’
column and the subsequent columns will be
repeated for each record.

No Expansion

The table will be populated ‘as is’. No
columns or rows will be added to the table.

An example of the generated XML can be seen
by making a selection in the panel, opening the
Table Options dialog and pressing the ‘Edit...’
button.
A preview of the XML will
area of the dialog. The
can also be testing using
resulting table shown in
window.

be shown in the top
XSL transformation
this dialog, with the
the bottom of the

• HTML/XML From Field Content

Use HTML or and XML fragment contained in
the selected field. If the field contains an HTML
table, it is not necessary to transform the field’s
content using XSL.

If this attribute has been specified using this dialog, it
will override the setting applied using the Pagination
Rules panel.

• Complex, Data Driven Table:

• Query an Existing Data Source

This functionality requires the XML Data Provider
Module.

‘Query an Existing Data Source’ requires the
Relational Module.

Allows the table to be populated with data from
another EasyCatalog data source. For example,
an ‘Accessories’ data source could be queried
for each ‘Product’ being paginated into the
document.
The query can refer other fields in record being
used to populate the table by including the
name of each field in { brackets }:
SELECT * from ‘Accessories’ where ProductID = {ProductID}
The {ProductID} will be replaced with the
contents of the ProductID field from the record
being used to populate the table.

The “Output” pop-up can be changed to specify
the format of the results returned from the query:

A ‘complex’ table takes XML data and transforms it,
using XSL, into an HTML table. This HTML table can
then be used to populate the table prototype.
• Source Data

The source XML data can be retrieved from a
number of locations:
• XML From Record(s)

©2003 - 2013 65bit Software Ltd. All rights reserved.
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This takes all fields and creates an XML structure.
Each field becomes an XML node. Any XML
fragments are appended into the structure.
Note that field names may be modified if they
are illegal XML node names.

• Simple, Design Driven Table:

HTML

Usage

<?xml version=”1.0” encoding=”UTF-8” standalone=”yes”?>
<Specifications>
<Specification name = “Volts” value = “130”/>
<Specification name = “Finish” value = “Clear”/>
<Specification name = “Master/Inner Carton” value = “120/10”/>
<Specification name = “Filament” value = “C-7A”/>
<Specification name = “Avg Rated Hours” value = “2500”/>
<Specification name = “Lumens” value = “60”/>
</Specifications>

The query results will be returned as an
HTML table. The table header will contain
the names of the fields returned by the
query; the table body will contain the field
values.
A simple XML structure will be returned,
which must then be transformed into HTML
using XSL:

XML

To populate a table with this data, it first needs to be
transformed into a simple HTML table using an XSL
Stylesheet:

<query>
<row>
<Quicklinx>11SS</Quicklinx>
<Manufacturer>Sony</Manufacturer>
<Description>ST-SE370S Silver E-Line Tuner</Description>
<Parent_Category>Audio Separates</Parent_Category>
<Child_Category>Analogue Radio Tuners</Child_Category>
<Ex_VAT_Price>$76.60</Ex_VAT_Price>
<Inc_VAT_Price>$90.00</Inc_VAT_Price>
<Availability>1-2 days</Availability>
</row>
</query>

<xsl:stylesheet
version=”1.0”
xmlns:xsl=”http://www.
w3.org/1999/XSL/Transform”>
<xsl:template match=”/”>
<table>
<xsl:for-each select=”//Specification”>
<tr>
<td><xsl:value-of select=”@name”/></td>
<td><xsl:value-of select=”@value”/></td>
</tr>
</xsl:for-each>
</table>
</xsl:template>
</xsl:stylesheet>

• XSL Transformation for XML Data

If the source data needs to be transformed into
HTML using XSL, click the ‘Edit’ button to enter the
XSL transformation. This dialog will also allow you
to test the results of the XSL transformation.

• Population Options

• Preserve Header / Preserve Footer

The resulting HTML is then merged into the table
prototype in the document.

The header and/or footer in the table prototype
will be used in preference to the header
information in the HTML table.

Merging Rules

• Start At Column

When merging the HTML data with the table prototype,
the number of rows in the table is expanded or contracted
to match the number of rows in the HTML table. When
adding rows to the table, EasyCatalog copies the first row,
then the second, then third to allow repeating patterns to
be defined.

The table prototype is populated starting at
the given column number. For example, the
prototype may contain a number of fixed
‘header’ columns that should not be affected by
the table population.

• Remove Empty Columns from HTML

The prototype table must contain enough columns to
accommodate the final data as this method of table
population does not add columns. EasyCatalog column
attributes should be used to remove empty columns and
resize them.

Empty table columns in the HTML will be ignored
when populating the table prototype.

Example Usage

A typical usage would be where the source data contains
an XML snippet in a field that needs to be output as a table
For example each product may have a “specifications”
field containing detailed technical specifications about a
product. This could be loaded into the field as an “XML
Fragment” via the XML Data Provider.

Column Ordering

Forcing data into a specific column can be achieved using
XSL, but this can be complex to implement. EasyCatalog
provides an easier way to shortcut this by specifying an
“index” attribute on the table column in the transformed
XML.

By default, columns are numbered starting at 100, so to
force a column to the left of the table specify a value less
than 100; to force a column to the right of the table specify
a large value such as 999. The following example shows
how to ensure that the ‘price’ column always appears on
the right of the table.
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Visit us at www.65bit.com

10

RELEASE NOTES

Attribute

UPPER(CELLCONTENT)

It is also possible to refer to the contents of other cells
in the same row, using the column header name in place
of the field name in the custom field function. If the table
does not have column headers each column will be given
a default name such as “Col 1”, “Col 2”, etc. An additional
field - “ROWINDEX” - is also available which evaluates to
the index number of the row (starting from zero) that the
cell is in.

• Added new options to ‘Cell Options’ dialog:

IF (FIELDSTR(“SALE”),=,”TRUE”, CELLCONTENT, ‘’)

Post Cleansing

The formatted cell value can also have cleansing applied
(see ‘Pre Cleansing’).

Apply Cell Style

Custom Field functions can be used to specify the name
of a cell style to apply to the cell: e.g.

IF (FIELDSTR(“PRICE”),>,100, ‘RED’,’BLUE’)

• Added support for setting form field names from a field
in the data using a Script Label configuration on the form
field’s frame:

When a table is defined as a ‘Complex, Data Driven’ table
extra options are available to format the contents of the
table cells.

<ecscript>
<formfield>
<name field="myfieldnamehere"/>
</formfield>
</ecscript>

Pre-Cleansing

Pre-cleansing is used to format the contents of a cell
before formatting is applied. This could be used, for
example, to clean up a price into a numeric value ready
for formatting. The format of the cleansing in this field is
the same as the Cleansing Options in the Field Options
dialog.



[1048]

• Added a search field to the “Group” dialog to help to
locate fields.
[1051]
• (Windows only) Added support for retrieving images from
HTTPS URLs.
[1055]

• Added keyboard modifier to “Update Document” to only
update fields, not re-apply Rule Sets. Hold down the ‘Alt’
key when selecting the menu.
[1051]

Formatting

Numeric Data

Enter the same formatting options as found on the
‘Custom’ numeric formatting options in Field Options.
e.g.

EasyCatalog Scripting Module

• Modified the ‘paginateIntoTextFlow’ script call to accept
either a pagination library or the name of a Rule Set.  [974]

[DECIMAL=’.’][THOUSANDS=’,’][PREFIX=$][PRECISION=2]

If non-numeric data is encountered in the cell content
‘NaN’ (not a number) will be output.

• The ‘applyConfiguration’ script call now accepts a file
path or the name of an existing configuration stored in
the workspace folder. 
[974]

Alphanumeric Data

EasyCatalog Relational Module

• Image previews are now supported in the Relational
panel. 
[1036]

Bug Fixes
The following bugs have been fixed in this release of EasyCatalog. For clarity, the bug reports listed below show the original
problem as reported. It is often not possible to detail the fix for each issue as they involve internal changes to EasyCatalog.
©2003 - 2013 65bit Software Ltd. All rights reserved.
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Cell content can be formatted using EasyCatalog’s
custom field functions. To refer to the content of the
cell, use the ‘CELLCONTENT’ keyword. For example, to
convert the content of the cell to upper-case:

<xsl:choose>
<xsl:when test = “($fieldname)=’Price’”>
<th index = “999” ><xsl:value-of select=”.”/></th>
</xsl:when>
<xsl:otherwise>
<th><xsl:value-of select=”.”/></th>
</xsl:otherwise>
</xsl:choose>

• The sorting of records is not always correct when using
linguistic sorting (by changing the “Language” setting on
the “Advanced” Field Options pane).
[961]

• A custom field configured with “Automatically Update
Content” off will still be processed if the custom field
is edited and one of the fields it references is missing.

[1008]

• Fields containing more than 64KB of text will be truncated.

[965]

• “File Data Source Configuration” dialog slow to appear
when data source contains a large number of records.

[1011]

• The “Replacement Image” is not always imported when
images are being imported from a URL. A malformed
URL can also cause the replacement image not to be
imported.
[963]

• A custom field configured with ‘Automatically Update
Content’ off is having its ‘in error’ flag reset when loading
a data source (and is not showing in red). 
[1009]

• The “SQL” custom field command will crash if the user
right-clicks on a field using this command and uses the
“Update Selected Custom Field(s)” option.
[971]

• The <img> HTML tag is not obeying width or height
attributes - the box should be resized to the specified
with and/or height. If either measurement is missing the
other will be calculated based on the proportions of the
image. 
[1017]

• If the user specifies only a filename in the ‘missing image’
field, it will not be imported from the ‘Images’ folder in the
workspace. 
[972]
•

• Importing image with a small fixed scale (e.g. 10%)
sometimes fails resulting in the image being imported at
100%. 
[1033]

The progress bars showing the ‘Updating Fields’/’Updating
Custom Fields’ operations are not progressing to the end
of the bar. 
[978]

• On the “Picture Content” pane in Field Options, the Fixed
Scale option will not accept values below 10%  [1035]

• InDesign will hang if too many parameters are specified
for a Custom Field 
[979]

• Crash when attempting to load an empty data source that
uses custom fields 
[1042]

• The direction of sorting (ascending/descending) can
now be specified in custom field group path and
sort parameters. Prefix each field name with ‘<’ for a
descending sort; ‘>’ for an ascending sort. If not specified,
default is ascending sort.

• The font used in the “Group” dialog is not drawing
correctly. 
[1043]
• (Macintosh only) The eSellerate engine cannot be installed
if the path to the plug-ins contains Unicode characters.

[1049]

Ascending:

• NFR serial numbers should not show activation errors for
any of the modules.
[1050]

GROUPSERIES('Parent Category,'>Ex VAT Price',1,1)

Descending:

• “Update Document > Selection” not always updating the
Rule that the cursor is positioned within.
[1058]

GROUPSERIES('Parent Category,'<Ex VAT Price',1,1)



[981]

• Images inserted by the <img> tag are not always inserted
in the correct position. Once an image has been inserted
subsequent tags are inserted one character too early in
the text flow.
[1060]

• Custom Fields are updated twice when right clicking
and using the “Update Selected Custom Field(s)” menu
option. 
[982]

• The language specified on the ‘Advanced’ Field Options
pane is not applied to fields flagged as ‘Formatted’ in
Field Options. 
[989]

• “Update Panel” is not always updating paths to images.

[1061]

EasyCatalog Pagination Module

• The language specified on the ‘Advanced’ Field Options
pane should be applied before the content is inserted into
the document to ensure that the correct typographer’s
quotes are used. 
[996]

• “Update Furniture” changing Z-order of page items.
If furniture items are stacked on top of each other, the
Z-order will be reversed when they are overridden on the
page. 
[973]

• ‘GROUPXREFFIELD’ is returning the record’s time stamp
if the searched-for record is not found. 
[1000]

• If the user has used Flow-based Pagination with a Rule
Set and also used the ‘Break On Field Change’ option,
when updating the document the page break characters
will be shuffled to the start of the text flow. 
[1020]

• ‘GROUPXREFFIELD’ could cause InDesign to hang if the
sort field is the same as the search field. 
[1001]

• Cell merging not comparing hidden/conditional text
content - it’s always failing and preventing a merge. This
affects fields that have the ‘Embed tags as conditional
text’ option set. 
[1002]

• Guide-based Pagination:

• Pagination will not always apply the specified master
page when paginating a Relational data source. [966]

• Pagination using a Rule Set will leave a portion of the
first spread empty when “Collision Detection” is on.

[990]

• REMOVEDUPLICATES custom field failing if string being
parsed contains empty string
REMOVEDUPLICATES(',','test,,test2')



[1006]
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EasyCatalog

• The “getLinks” method is not returning the data source
name or key field value for image boxes. 
[997]
• Adopt fields should default to ‘ignore’ items that are in the
document but not in the data source 
[1032]

• Continuation headers could be inserted before the
initial group header. 
[1053]

EasyCatalog ODBC Data Provider Module

• Pagination will sometimes miss first guide on page
when paginating across/down with a keep-with-next
header. 
[1054]

• ODBC Data Source Configuration dialog slow to appear
when data source contains a large number of records.

[1011

EasyCatalog Scripting Module

EasyCatalog Relational Module

• The “updateTags” method is not updating fields in tables.

[995]

• The Relational data panel crashes when a group has only
one column. 
[1046]

Version 6.2.1/9.0.1

26 July 2013

Bug Fixes
EasyCatalog

• (CC9) Serial numbers are overwriting the CS6 EasyCatalog
serial numbers.
[958]

• When using flow-based pagination to paginate a Rule Set
the grey marker characters can sometimes be inserted
in the wrong position. This usually affects Rules that are
set to insert ‘Frame Contents’ that consist of only a table.

[940]

EasyCatalog XML Data Provider

• Crash when updating XML Data Source if the same node
is referenced twice for two different fields.
[957]

EasyCatalog Pagination Module

• Unable to click group pop-up on Table > Row Options
dialog.
[952]

• Slow text-flow pagination

[964]

Enhancements
EasyCatalog

EasyCatalog Scripting Module

• Added new custom field function to round a numeric value:

• Added scripting call to assign a rule name to box:

ROUNDVAL(FIELDSTR(Number),2,FALSE)

var myRect = myDocument.textFrames.item(0);
myRect.formattingRuleName = "xxx";



Parameter 1 is the value to round; parameter 2 is the
precision to round it to; parameter 3 will strip any trailing
zeroes when set to TRUE.
[941]

[941]

• Added scripting call to lock a rule on the page:
var myRect = myDocument.textFrames.item(0);
myRect.formattingRuleLock = true;
myRect.formattingRuleLock = false;
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• Guides that have been overridden from a master page
and then deleted are still used as valid positions - i.e.
items are placed at positions that cannot be seen. [988]

28 June 2013

Enhancements
EasyCatalog

• Added a new custom field to retrieve the status of a field.

• Version 9.0.0 adds support for InDesign CC (version 9).

DSSTATUS('myfield')

This will return either inserted, updated or nothing.

• Minor interface changes to support new colour themes
in InDesign CC.

[935]

• Added a new custom field that will retrieve data from a URL.

• Adopt Fields improved to remove any invalid marker
characters for Rule Sets.
[923]

URLSTR('http://www.65bit.com/my.php')



• Added support for inserting fields into the Notes panel.

[924]

[939]

EasyCatalog Pagination Module

• Added support for Position Indexes such as 1:2 in Masterbased pagination. This allows groups and sub-group
indexes to be specified.
[920]

• Added ability for URL image and XML imports to follow
redirects returned from the web server.
[926]

• Custom Field functions that cannot be executed as
InDesign is starting (such as ‘CALLSCRIPT’) will now be
deferred until InDesign has started.
[933]

Bug Fixes
EasyCatalog

• Numeric values being incorrectly rounded.

• Duplicating the same Formatting Rule twice causes
InDesign to hang.
[916]

[936]

Images and Image Previews
•

Images can now be previewed in the EasyCatalog data panel by hovering over the
image field in the panel.
To see image previews in the panel:
•
•
•

•

Multiple images can now be stored in a single field within EasyCatalog,
and the one to use during placement or pagination can be selected in the
panel.
•
•
•

•

 nsure that ‘Text and Image Previews’ is selected in the Panel Preferences. To
E
access the “Panel Preferences” dialog right-click in the data area of the panel and use the “Panel Preferences”
menu option from the contextual menu that appears.
Only fields that have a ‘Content Location’ specified will show image previews. If your data contains a full path
to the image, you must still ensure that you configure a path in the Field Options. This path will be ignored for
the purposes of importing the images.
Images imported from a URL will only have previews available when the images have been downloaded
and cached locally. Images will be cached locally after initial placement in a document or after using the
“Images → Download All” menu option from the data panel’s pop-out menu.

Images should be separated by a carriage return in the source data.
When hovering over an image field containing multiple images, all
images will be previewed. The image to use when importing this field can be selected by clicking on the preview.
This functionality is not supported when importing images from URLs.

Image previews can be dragged and dropped to the document. The image will be imported and linked to the field
in the panel.

• Image previews are now visible in the Record Viewer panel and in the main EasyCatalog data panel.
©2003 - 2013 65bit Software Ltd. All rights reserved.
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Version 6.2.0/9.0.0

RELEASE NOTES

Quick Search
• Added a new ‘Quick Search’ text field to the panel. The panel will be
filterered by the text entered into this text box. By default, any field
containing the text entered will be shown in the panel. The search is case
insensitive.
To search for fields beginning with the specified text, suffix the text with an
asterisk:
App*

To search for fields ending with the specified text, prefix the text with an asterisk:
*pple

To search for fields containing only the specified text, enclose the search term in quotes:
"Apple"

Fields containing the selected text are highlighted in yellow

The number of fields containing the text entered

The ‘Quick Search’ field

These rectangles show the position of the columns that contain fields containing the text
Groups that were previously closed will be temporarily opened so that the search results are visible

• Added keyboard shortcut ‘Enter Quick Search’, which will give keyboard focus to the Quick Search text field in the last
panel used.
[709]

• Added keyboard shortcut ‘Quick Search Selection’ which will place the text currently selected in the document into the
Quick Search field in the last panel used.
[710]
• A dialog box asking whether Smart Catalog links should
be adopted sometimes appears when there are no Smart
Catalog links to adopt.
[919]

• Paragraph styles applied to the first paragraph in a
Formatting Rule can sometimes be lost when inserting
‘Frame Contents’
[929]

• Notes can sometimes be deleted during ‘Adopt Fields’

[925]

• Document report does not open if the InDesign document
contains accented characters (Mac only)
[931]

• InDesign index markers can sometimes be deleted during
‘Adopt Fields’
[928]
©2003 - 2013 65bit Software Ltd. All rights reserved.
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• Added new scripting call on the DSV object to generate a
UTF-8 formatted file containing the records for the view.

[922]

EasyCatalog Pagination Module

• Some images cause EasyCatalog to crash when displaying
a thumbnail preview.
[934]

• Master-based Pagination is not overriding boxes in groups
correctly. 
[921]

• A custom field that has been converted to a normal field
is not having its error state reset and will always show as
‘in error’.
[937]

• Product Styles are sometimes being left behind after
a guide-based pagination that used Formatting Rules
rather than a Pagination library. 
[932]

EasyCatalog Scripting Module

EasyCatalog Relational Module

• If a box has been deleted during Pagination the next
script call can sometimes fail.
[917]

• Crashes on 64bit version of InDesign Server.

Version 6.1.0

[927]

4 April 2013

Enhancements
EasyCatalog

• The cell pickup dialog has a new option “Columns On
Right”, which populates fields in a table from right to left.

[838]

• This version adds a new way to paginate data: Rules and
Rule Sets. Using Rules and Rule Sets, it is possible to
configure a pagination that is fully updatable: including
the ability to automatically insert new records and
delete records in the correct position in the text flow.
It is also possible to edit the original Product Style that
was used to paginate data and update the document with
these changes.

• Added option to specify Photoshop clipping path when
importing an image. This is specified in the Field Options
for the field.
[839]
• Added keyboard navigation for the panel when the quick
search text box has keyboard focus.
[859]
• Ability to use cursor keys in Record Viewer panel to move
to next/previous record
[861]

Rules and Rule Sets do not use traditional Pagination
Libraries - instead, Product Styles are stored in the
document as snippets and pagination rules are assigned
to them using the new Formatting Rules panel.

• HTML parsing enhancements

• <small> now applies small caps character attribute.

• The following table attributes are now supported by
the HTML parser:

Further information on Formatting Rules can be found in
the Formatting Rules chapter from the new manual which
can be downloaded from here:

<TABLE>
Attribute

http://www.65bit.com/downloads/documents/
Formatting Rules.pdf

An updated User Guide will be available shortly
incorporating this new chapter.

• Ability to prevent missing images being shown as ‘in
error’
[80]

• Added keyboard modifier to export custom field content.
Hold down the Alt key when using the ‘Update Data
Source’ menu option. 
[818]

Usage

CLASS/STYLE

The name of an InDesign table style

WIDTH

The total width of the table. All
InDesign-supported
measurement
units can be specified in this attribute
or a percantage of the containing text
box’s width.

• New Custom Field command to sort a delimited list.
SORT(TRUE,',','D,B,A,C,F')

The first parameter should be set to ‘TRUE’ to sort the list in
ascending order; ‘FALSE’ to sort the list in descending order.
The second parameter specifies the separator used in the
list, the third parameter specifies the list of items to sort.
Additional lists can be specified in optional parameters:
SORT(TRUE,',',FIELDSTR(field a), FIELDSTR(field b))



[828]
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• If a document contained in an InDesign book contains
a Field Specifier, the dialog that appears after using the
“Update EasyCatalog Fields” option will show a missing
data source with no name.
[930]

• Added a new custom field - ‘APPLYXSLT’
- to apply an XSL transformation to the
contents of another field in the data source.

<TH>/<TD>
<TH> rows are created as InDesign table header rows;
<TD> rows are created as InDesign body table rows.
CLASS/STYLE

APPLYXSLT(myField,'transform.xsl')

WIDTH

Width of the table column. Keywords
can also be used to specify one of
EasyCatalog’s column properties:
FIXED, VARIABLE, FITTOTEXT

HEIGHT

The height of the table row. The
height can be specified using any of
InDesign’s supported measurement
units.

VMERGE

Specifies an EasyCatalog
vertical merging attribute. Can
be one of CONTENTMATCH,
POPULATEDCONTENTMATCH

HMERGE

Specifies an EasyCatalog
horizontal merging attribute. Can
be one of CONTENTMATCH,
POPULATEDCONTENTMATCH

DELETE
COLSPAN/
ROWSPAN

The contents of the field specified in the first parameter
should be XML; the XSLT file specified in the second
parameter should be placed in the XSLT folder inside of
the workspace folder.

The name of an InDesign cell style

This function requires a licensed copy of the XML
Data Provider module.

• Added a new custom field - ‘EVALUATEXPATH’
- to retrieve the contents of the given node or
attribute from the XML contents of another field:
EVALUATEXPATH(Options, '//Option1/@col1', ',')

The first parameter specifies the field containing the XML
fragment; the second parameter specifies the XPath
to resolve. If the XPath retrieves multiple values they
will be separated by the character specified in the third
parameter.
This function requires a licensed copy of the XML
Data Provider module.

• Added a new custom field - ‘REMOVEDUPLICATES’ - to
remove duplicated entries from a delimited list:

Specifies an EasyCatalog row
deletion property, can be one of
NEVER, IFEMPTY

REMOVEDUPLICATES(':','A:B:D:A:B:A')

The first parameter specifies the separator used in the list
of items in the second parameter. Duplicated entries will
be removed.

Standard HTML row and column
spans.

• Added a new custom field - ‘SQL’ - to execute an SQL
command that will return data from any EasyCatalog data
source.

• Added support for specifying which font face should
be used when applying bold and italics:
<b boldface = “SemiBold” plainface = “Regular”>



SQL('select * from STOCK.CSV', xml)

[866]

Data Sources can be referenced in the same manner as
database tables. The second parameter specifies the
format of the output from the query and can be one of:

• Add a new script label to specify a table to be a fixed
width
[869]

• Added a new option to the Configuration ‘Save As’ dialog
to enable field options to also be saved with the panel’s
view configuration. This allows the user to also switch
between different field options configurations. 
[874]
• Support for inserting a link when using the Story Editor.

[876]

• Performance improvement for GROUPXREFFIELD custom
field.
[885]
• Cell styles are now be reapplied during an ‘Update
Document’ operation. A cell style can only be reapplied
to a cell if it contains a linked data field.
[894]

• Holding the shift key down while using Replace Fields will
not replace any existing image content (it will only replace
the field tag)
[895]

• The Character Style popup on the Field Options dialog
now allows styles stored in a character style folder to be
specified.
[896]
• Right click menu and tool tip support for Relational panels

[854]
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Visit us at www.65bit.com

17

RELEASE NOTES

• <TH> and <TD> tags support the following attributes:

html

The results are returned as an HTML
<table>

htmlnoheader

The results are returned as an HTML
<table> that does not contain column
headers.

text

textnoheader

• Added new property - fieldNames - to the Data
Source object to access a list of field names.
var myEC = app.easycatalogObject;
var myDS = myEC.datasources.item("Stock.CSV");
var myDSFields = myDS.fieldNames;
for (index = 0; index < myDSFields.length; index++){
alert(myDSFields[index]);
}



[851]

• New scripting call to apply Pagination Rules to page objects:
myobject = app.selection[0];
var myEC = app.easycatalogObject;
myEC.setPaginationOption(myobject, "type",
"0x92100kTypeValueItem");

The results are returned in a tabdelimited format.
The results are returned in a tabdelimited format, but field names are
excluded from the first row.



[822]

• DSV object now has a ‘visible’ property
• New
scripting
call
to
markers from the current

This function requires a licensed copy of the Relational
Data Provider module.

[835

remove
the
field
document selection

var myEasyCatalog = app.easycatalogObject;
var myDoc = app.activeDocument;
myEasyCatalog.removeSelectedFieldMarkers();

EasyCatalog Pagination Module

• Performance improvement for guide-based pagination

[857,891]



[835

• New scripting call to delete a record from a data source

• Ability to specify max/minimum frame size on Fitting ➝
Frame Depth to Content Depth
[862]

var myEasyCatalog = app.easycatalogObject;
var myDS = myEasyCatalog.datasources.item("Stock.
CSV");
var myDS = myDS.records.item("11SS").remove();

• Addition of ‘Restrict vertical merging to page bounds’ to
Guide-based pagination
[867]



• Master-based pagination now support Relational data
sources.
[875]

[835

• Added DataViews object to EasyCatalog object which is
a list of all open data views (regardless of which data
source they belong to)
[864]

• Guide-based pagination automatically detects double
page items and places them on a left-hand page.
[841]

• dataSourceSpecifier property now accepts POSIX paths
on Mac (File Data Provider data sources)
[882]

EasyCatalog XML Data Provider Module

• Added the ability to load part of the XML structure into a
field (rather than specifying an individual node or attribute
to import).

• Added a new method to update the data snapshot
with the selected fields in a DSV (equivalent to Update
Panel➝Selection
var myEC = app.easycatalogObject;
var myDV = myEC.selectedDataView();
myDV.updateSelectedSnapshot(app.activeDocument);



Use the ‘Load As XML Fragment’ check box to load the
specified node - and its children - as an XML fragment
into the field.

var myEasyCatalog = app.easycatalogObject;
var myDS = myEasyCatalog.datasources.item("Stock.
CSV");
var myRecord = myDS.records.item("11SS");
if (myRecord.markedasupdatedlocally) {
for (j = 0; j < myRecord.fields.length; ++j) {
		
var myField = myRecord.fields.item(j);
		
if (myField.markedasupdatedlocally) {
			
alert(myField.name);
		 }
}
}

• Added support for the ‘APPLYXSLT’ custom field function.


EasyCatalog Scripting Module

• New method to add a field to an XML data source.
var myEC = app.easycatalogObject;
var myDS = myEC.datasources.item("Stock.CSV");
myDS.addField("value", "/value/text()");



[887]

• Added new property to record and field objects
- markedasupdatedlocally. The property on the
record object will return true if any of the fields
have been updated; the property on the field
object will return true if it has been updated.



[850]
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xml

The query results are returned in an XML
structure. This is useful if these results
should later be transformed using the
APPLYXSLT function.

RELEASE NOTES

EasyCatalog Relational Module

• When holding the shift key and using the ‘Synchronize
with Data Source’ menu option to change the source data
file all data sources using the same original data file will
be modified to use the new data file. 
[908]
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The following bugs have been fixed in this release of EasyCatalog. For clarity, the bug reports listed below show the original
problem as reported. It is often not possible to detail the fix for each issue as they involve internal changes to EasyCatalog.

EasyCatalog

• Adopt Fields doesn’t always clean-up field marker
characters
[884]

• GOOGLEQRCODEURL is using https instead of http https is not supported on Windows for retrieving images
from a URL.
[813]

• Image tool-tips don’t always appear when column is fixed

[888]

• When overriding a master page furniture box sometimes
the box will shift position on the overridden page.  [815]

• Update Panel With Page Numbers should use section
page numbers
[893]

• Panels that are open but hidden will sometimes appear
empty when shown if the user has performed an operation
such as ‘Update Furniture’ which attempts to refresh all
open panels.
[814]
• Images can be imported into non-graphic frames 

[817]

• Panel scrolls to right when resizing columns 

[825]

• Updating x and y offset and picture scale incorrect when
decimal separator is not ‘.’
[897]

• Tool Tip attempts to show all text in field which can cause
performance issues.
[898]
• (CS6) Conditional text not always applied correctly when
‘Embed Tags as Conditional Text’ is on.
[899]

• InDesign crashes when attempting to run ‘CALLSCRIPT’
command during startup 
[824]

• ‘Preserve Formatting on Update’ should be ignored if
‘Embed Tags’ is on
[902]

• Auto Fill Tables not working when table header rows have
spans 
[826]

• Update Document not updating document if Pagination
Module not loaded
[903]

• Auto Fill Tables not working when table headers contain
hard/soft returns 
[827]

• Importing FDEF file can create custom fields flagged as
key fields
[905]

• Custom Fields are processed in records marked as
deleted 
[829]

• SNIPPETDEPTH/SNIPPETWIDTH commands sometimes
fail to execute
[911]

• The error report generated when importing images from
a URL does not include the name of the field that caused
the error 
[837]

• When InDesign’s ‘track changes’ feature is enabled, fields
in deleted tracked text are being processed
[912]
• Fields in hidden conditional text showing as ‘in error’ [913]

• CS6 version reading/writing CS5/CS5.5 serial numbers
file
[845]

• InDesign can crash when deleting text from a document.

[914]

• Images imported from a URL should not be updated by
Update Panel
[846]

• Error message when CSV file can’t be loaded incomplete
(missing file name)
[881]

• Exclude from ‘Update Panel’ option ignored for image
fields
[847]

• Error overriding master page item when inserting new
pages during pagination
[811]

• Table column option ‘Fit To Content’ not working with
bulleted lists
[848]
• Image tool-tips don’t always appear 

• Master-based pagination shifting page items when
overriding on page
[830]

[852]

• Crash paginating matrix table from relational data if field
not found
[833]

• Populating a Product Style leaves a single box group box
(If boxes are deleted from a group it’s possible to end-up
with a group containing a single box)
[856]

• Added ‘headercolumnsfixedwidth’ attribute to matrix table

[834]

• Panel preferences should be greyed out if InDesign’s tool
tips are turned off
[858]

• Overriding master page items during auto page insertion
shifts page item
[842]

• (CS6) ‘New EasyCatalog Library’ option not appending
.indl extension to filename.
[860]

• Furniture boxes should be deleted when there is no data
to populate them
[849]

• (CS6) ‘Paginate’ dialog does not allow libraries without
.indl file extension to be selected.
[860]

• Odd/Even Page Break not working with guide-based
pagination
[853]

• Update Furniture crash when removing existing furniture
overrides
[863]

• Guide-based pagination to use separate spread to
paginate library items
[855]

• Unhandled exception in ECVerticalTableMerge.cpp at line
307
[865]
• Crash when data source contains no records

• If a Product Style is configured to place on a left-hand
page and the paginated item is longer than a page, a
page break character will be inserted and the item will be
placed on a right-hand page. This results in a blank page.

[868]

[873]

• GROUPXREFFIELD not always working when search field
is the same as the sort field
[879]
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• paginationYPosition field not being populated during
guide-based pagination
[871]
• paginationYPostion being updated too often during
pagination
[872]
• Picture scale options not always applied

[877]

• Minimum and maximum height attributes sometimes use
wrong measurement system
[889]

• Guide-based Pagination gets stuck in loop when using
collision detection and break on field change
[892]

• Guide-based Pagination leaving product style on page if
all boxes deleted
[900]
• Position-based pagination not working with Relational
Data Sources
[904]
• Pagination error: An error occurred moving the library
item to the top left of the spread
[907]
• Fitting ➝ Frame Depth to Content Depth not working on
sheared boxes
[909]
• Memory leak in relational module

[906]

• sortDataView ascending flag not working with Relational
views
[819]
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16 May, 2012

Enhancements
EasyCatalog

• Added ‘I2OF5’ function to convert the given numerical
value into interleaved 2-of-5 barcode glyphs in the font
‘Dobson2OF5’.

• Added new right-click menu option on panel - ‘Hide Empty
Fields’ which will hide columns that have no content. [737]
• New custom field command - CHAR - which will return
a character for the given unicode character code.

I2OF5(FIELDSTR(mycode))



Prefix
to

the
specify

character
code
with
%
a
hexadecimal
value:

CHAR(%80)



[808]

• Custom fields should now be evaluated in dependency
order - i.e. field values that are dependent on other field
values. A new error state has been introduced which will
prevent cyclic dependencies (two or more fields whose
values are dependent on each other).

CHAR(128)

[511]

EasyCatalog Pagination Module

• The size of the image preview shown in the tool-tip can
now be modified by right-clicking in the panel and using
the ‘Panel Preferences’ option.
[744]

• Applying master pages will now look for a master page
using the full name (e.g. ‘A-Master’) or the base name
(e.g. ‘Master’). 
[743]

• Modification to SNIPPETDEPTH to look in the workspace
‘Assets’ folder if a full path for the snippet is not provided.

[739]

• Added option to remove already-overridden furniture
boxes when running the ‘Update Furniture’ operation. [750]

• Some Product Styles are imported at the wrong size
when ‘Allow Pagination to be Undoable’ is switched off.

[759]

• Reports now include EasyCatalog version and build
number. 
[742]

• New user interface on the panel to allow user to quickly
switch between configurations. Use the right-click ‘Panel
Preferences’ option to turn on the ‘Show Configurations’
option. Any configurations that have been set-up will be
shown as tabs along the top of the panel. 
[746]

• Attributes that are dependent on other attributes will be
indented in the Pagination Rules panel.
[761]

• Added ‘Apply Master Named In’ option to Position-based
pagination.
[763]
• Master-based pagination will skip over pages in the
document that have no boxes with a Position Index
specified.
[778]

• ‘Adopt Fields’ should now ignore white space around field
names and key field values when attempting to find the
fields in the new data source. 
[754]

• Guide-based Pagination Only:

• Added new field to Field Options to allow user to specify
which characters should be ignored when using the
‘Ignore White Space Changes’ option. 
[774]

• New Pagination Rule: ‘Keep With Next’ which will
attempt to keep the library item with the item that will
be paginated next.
[748]

• When working with html-formatted fields a ‘style’
attribute can be provided on the <li> tag which specifies
the paragraph style to use in InDesign. 
[781]

• New Pagination Rule to automatically insert column or
page headers. The ‘Repeat’ attribute can be set on a
library item to specify that it should be repeated at the
start of each new page or column.
[749]

• Added new optional parameter to the GROUPMIN
and GROUPMAX functions to specify whether empty
values in the group should be ignored (TRUE = ignore;
FALSE=don’t ignore). 
[789]

• If present, a field called ‘paginationXPosition’ will be
populated during pagination with the X position of
where the library item is about to be positioned. This
field can then be used in a Pagination Rules action to
make decisions based on its pagination position. [755]

• Speed improvement when re-creating formatted content
for non-custom fields. 
[790]
• Added progress bar when updating non-custom fields.

[791]

• ‘Cell Finder’ now works with tables that do not have an
InDesign header row. 
[792]
• New custom field function to create a list of unique values:
DISTINCTLIST(',',FIELDSTR(Field A),FIELDSTR(Field b))

The first parameter is the separator to use in the list;
subsequent parameters specify the values to create a
distinct list of.
[799]
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2. Record key value

• New scripting call to retrieve the EasyCatalog fields in the
given page item.

3. FIeld name 

[805]

• Added new script call to navigate through a relational
data view hierarchy.

var myEasyCatalog = app.easycatalogObject;
var myPageItem = app.selection[0];;
var mySelection = myEasyCatalog.getLinks(myPageItem);
for (index = 0; index < mySelection.length; index += 3)
{
alert(mySelection[index + 0] + "-" +
mySelection[index + 1] + "-" + mySelection[index
+ 2]);
}

var myEC = app.easycatalogObject;
var myDS = myEC.datasources.item("Relational");
var myDV = myDS.dataviews.add();
myDV.makeSelection(1,1);
myDV.groupDrillDown();
myDV.makeSelection(1,1);
myDV.groupDrillDown();
myDV.groupUp();
myDV.groupUp();

The new ‘getLinks’ call will return an array of strings, three
strings per link:

groupDrillDown will go in to the selected group; groupUp
will go up to the group level above the current position.

[806

1. Project Name

Bug Fixes
The following bugs have been fixed in this release of EasyCatalog. For clarity, the bug reports listed below show the original
problem as reported. It is often not possible to detail the fix for each issue as they involve internal changes to EasyCatalog.

EasyCatalog

• Library items will sometimes be incorrectly populated
with data even when the ‘EasyCatalog Library’ option is
switched off.
[773]

• SNIPPETDEPTH can return incorrect depth when the
snippet has attributes or actions applied which delete
content. 
[738]

• Potential crash when exporting the document report text
file from the Information dialog .
[777]

• Group rows are not displayed correctly in the panel if the
group name contains a carriage-return. 
[747]

• ‘Unhandled exception in ECProductStyle.cpp at line
1415’ error.
[779]

• Arial font being incorrectly applied to some characters in
formatted fields even though the glyph is available in the
font that is applied.
[753]

• EasyCatalog should check that the workspace folder
exists before attempting to create the ‘EasyCatalog Data
Source Templates’ folder.
[784]

• Update Panel > With Page Positions bug fixes:
• Not updating the position of image boxes

• The ‘Content Type’ setting is being ignored

• Overriding default HTML tags should not be case
sensitive.
[786]

[756]
[757]

• The panel will not be updated correctly if the prefix or
suffix contains metacharacters .
[793]

• When the ‘Records’ option is used the position of
image boxes is not being updated
[758]

• Some boxes in a Product Style will not be populated if
the majority of the boxes have a ‘bring to front’ / ‘send to
back’ action.
[807]

• The page number is being used to populate the fields
when ‘Selection’ is selected in the dialog.
[803]

• Images do not always fit correctly when crop settings
have been applied to the box.
[762]

ODBC Data Provider

• Update Panel is updating panel content unnecessarily for
images.
[764]

• Removed 50 character limit on data source template
parameters. 
[740]

• Update Panel is not updating image X, Y and offset values
if the fields are custom fields.
[765]

EasyCatalog Pagination Module

• ‘Release Anchored Objects’ not working after a grow-andflow box resize. 
[745]

• Update Panel is incorrectly warning about not being able
of update key field values when updating the X, Y and
offset fields if the image has been imported from a key
field value.
[766]

• Some text boxes will cause the ‘amount of overset
text has not been reduced’ error to be displayed if they
contain anchored boxes that affect the text flow. 
[775]

• Image import does not obey X, Y and scale if any of the
fields are empty.
[767]

• Pagination crashes when running under InDesign server
when attempting to retrieve the current page. 
[782]

• Preview not updating in data source configuration dialog
when changing field options.
[769]

• Delete action crashing when running under InDesign
Server. 
[783]

• Windows version crashing when using the ‘Close All’
window option.
[771]

• Relational groups are not showing in the ‘Positions Are’
pop-up for Master-based pagination.
[772]
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EasyCatalog Scripting Module

• Using the ‘Show’ pagination rule has no effect.

[752]

• Position-based pagination sometimes shows a ‘Field
Not Found’ error when attempting to paginate Relational
data.
[741]

• When setting a ‘Show’ pagination rules action, it will be
listed as ‘Hide’ in the Pagination Rules panel.
[751]

Version 5.0.6/5.5.6

12 January, 2012

Enhancements
EasyCatalog

• The ‘GETBARCODEGLYPHS’ function now supports the
EanP30G font.
[727]

EasyCatalog Scripting Module

• Added new scripting call on the data source object to
generate the document report at the path specified by the
second parameter.

• Added new ‘Paginate’ keyboard shortcut to show the
‘Paginate’ dialog for the selected data source.
[697]

myDS.reportDocument(myDoc, "Macintosh
HD:Users:markhaden:report.xml");

EasyCatalog Pagination Module



• Added maximum and minimum height parameters to the
‘Grow and Flow’ pagination attribute.
[726]

[730]

Bug Fixes
The following bugs have been fixed in this release of EasyCatalog. For clarity, the bug reports listed below show the original
problem as reported. It is often not possible to detail the fix for each issue as they involve internal changes to EasyCatalog.

EasyCatalog

• Fields with a forward slash in their names cannot be
replaced using the ‘Replace Fields’ dialog.
[721]
• Scroll bars on the ‘Group’ dialog don’t always appear
when showing the dialog for a second time.
[722]

• Alphanumeric ‘Formatted’ fields are not showing as ‘in
error’ in the panel when the content in the panel does not
match the content in the document.
[723]
• The options on the ‘Adopt Fields’ menu on the Record
Viewer/Lite panel were transposed, so ‘All’ adopts the
current layer and ‘Current Layer’ adopts all.
[725]

• The ‘Starts with’ Quick Search returns too many results.

[728]
• When adding new fields to the source data, every record
is shown as ‘deleted’ and ‘inserted’ after a ‘Synchronize
with Data Source’ operation.
[731]

• XREFFIELD fails to find fields in external data sources.
This only occurs if the custom field is evaluated whilst
InDesign is launching.
[732]
• Custom fields are not being updated after ‘Update Panel
with Page Numbers’
[733]
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• Master-based pagination should now work correctly
with Relational data sources. Records from the group
specified by the ‘Positions Are’ pop-up will be used. [788]

1 December, 2011

Enhancements
EasyCatalog

• The ‘GETBARCODEGLYPHS’ function now supports the
‘UPCHEIGHTDREDA’ font.
[689]

• Quick Search text search and keyboard shortcuts details on following page.
[709, 710]

• Template data sources can now be stored hierarchically in
the EasyCatalog workspace folder. Data sources created
from them will appear in the same sub-folder within the
workspace folder.
[691]

• Added a ‘CODE128’ custom field function to output
a Code 128 barcode using the Code128bWin/
Code128bWinLarge font which can be downloaded from:
http://freebarcodefonts.dobsonsw.com/installing-freebarcode-fonts.html
[678]

• ‘Adopt Fields’ has been added to the Record Viewer/
EasyCatalog Lite panel.
[703]

• (Windows only) Upgraded to the latest eSellerate Engine
which should help with permissions problems when
installing the engine on some machines.
[680]

• Added confirmation dialog to the ‘Close Panel’ menu
option.
[707]

• Scroll bars now resize proportionally based on the amount
of data visible.
[708]

• The HTML <table> tag now supports:

• the ‘width’ property, which can be in any unitof-measure supported by InDesign, or ‘auto’ to
automatically horizontally resize the table to be the
width of the column it is placed in.
[681, 682]

• An additional option is available on the ‘Cell Options’
dialog to ignore empty cells when merging horizontally
or vertically. This will prevent cells with no content from
being merged together.

• the ‘class’ and ‘style’ property, which can be used to
apply an InDesign table style.
[682]

Bug Fixes
The following bugs have been fixed in this release of EasyCatalog. For clarity, the bug reports listed below show the original
problem as reported. It is often not possible to detail the fix for each issue as they involve internal changes to EasyCatalog.

EasyCatalog

• The ‘file extension’ specified in Field Options
is always being prefixed with a ‘.’.
This is not
always correct, as the user may want to use:

• When using the ‘Break on Field change’ option on the
Paginate dialog and a library item that also has an odd/
even page break attribute set, pagination will stop with a
‘unable to insert pages’ error. 
[683]

_ Y.psd;.psd

to import a file ending in ‘_Y.psd’ or ‘.psd’.

• ‘Ignore Whitespace Changes’ should ignore zero-widthno-break characters, such as index markers.
[684]

[695]

• ‘Adopt Fields’ on the book panel menu displays the ‘Do
you want to add missing records’ once per document.

[698]

• Using the ‘First Record Contains Field Names’ check-box
on the ‘New File Data Source’ dialog crashes. 
[685]

• ‘Update Panel’ adds prefix or suffix to field content if the
prefix or suffix contains a custom field function.
[700]

• SNIPPETDEPTH bug GROUPSNIPPETDEPTH bug fixes:

• ‘Record Viewer’/EasyCatalog Lite panel not updating
after user presses the ‘Delete’ button to delete the data
source. 
[704]

• SNIPPETDEPTH sometimes gives error about box
moving off spread. When using the frame fitting
options in the snippet, sometimes the user will receive
an error about the box being moved off the spread and
the function fails. 
[686]

• The character style sheet specified in Field Options is not
applied the the [ field marker ] characters.
[705]

• SNIPPETDEPTH doesn’t work if snippet resizes bigger
than current document depth. 
[687]

• ‘Update Panel’ will include the suffix in the field content
if the prefix is the same as the suffix or the field content
contains the suffix.
[706]

• SNIPPETDEPTH doesn’t work if there is no document
open.
[688]

• When dragging a page item to a row in the panel, if the
key field contains colons or slashes the operation will fail
with an error.
[711]

• SNIPPETDEPTH and GROUPSNIPPETDEPTH should
not execute when InDesign is starting up as it will fail
to execute.
[690]

• Conditional logic parser fails if the text preceding the
statement contains an ‘@’ - e.g.

• EasyCatalog crashes when downloading an image from a
long URL.
[692]

Call fullname @ phone
at email@@endif@@

• Occasional crash when double and triple clicking in the
panel around an image preview.
[694]
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RELEASE NOTES

• ‘Restrict Vertical Cell Merging to Page Bounds’ will
sometimes crash.
[713]

• ‘Remove Blank Lines for Empty Fields’ will remove a
paragraph if it contains empty image boxes, even though
it also contains populated text field content.
[715]
• ‘Remove Blank Lines for Empty Fields’ leaves an empty
paragraph at the end of the story if the final paragraph
contains empty fields.
[716]

• ‘Selection’ option on the Record Viewer Panel/
EasyCatalog Lite panel does not show any results if the
user has a table selection.
[718]
• ‘Update Selection’ keyboard shortcut slow when user has
a lot of data sources.
[719]

EasyCatalog Pagination Module

• Some paginations may crash when using the ‘When
Frame is Empty → Delete’ pagination rule.
[693]

• French translation for ‘Remove Blank Lines for Empty
Fields’ is wrong: the ‘yes’ and ‘no’ strings were switched.

[696]

EasyCatalog Relational Module
• Crash
Hierarchically’

when
query

is

‘Group
malformed

Repeats
e.g:

WHERE parent _ item _ category _ uid = {child _ item _
category _ uid:}



[699]
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17 October, 2011

Enhancements
EasyCatalog

• Field Options for multiple fields can now be edited at
once. Alt-click on the column headers to select the fields
to be edited, then use the right-click contextual menu to
edit the Field Options. Note that all settings shown in the
Field Options dialog will be copied to all of the selected
columns, not just the settings that have been modified.

• A new Field Option has been added that allows a field to
be nominated that contains either the name of a swatch
or an RGB value of a colour to apply to an image. RGB
values should be prefixed with a #.

Custom Fields


• Custom fields can now be identified in the panel by the
‘function’ icon in the column header. 
[613]

[601]

• Added new Field Option to support the embedding of
formatting tags as hidden InDesign conditional text. This
allows the panel to later be updated whilst retaining the
formatting tags.

• New option added to the Custom Field Field Option’s
pane: ‘Automatically Update Content’. When this is turned
off the content of this custom field will only be updated
when using the ‘Update Selected Custom Fields’ rightclick menu option.
• New custom field command ‘SUB’ to subtract each
parameter from the previous.
[591]

EasyCatalog will create InDesign Conditional Text called
‘EC-Formatting-Hidden’ and ‘EC-Formatting-Visible’ to
store both the original formatting tags and their equivalent
document content (in the case of character entities).

• XREFFIELD custom field function can now search for
fields containing the specified string, or fields starting or
ending with the specified string.

Prefix and suffix the ‘search for’ string with ‘%’ to search
for a field ‘containing’ the specified text (e.g. ‘%findme%’).

The EC-Formatting-Hidden Conditional Text will contain
formatting tags such as <b> and entities such as &nbsp;.
The EC-Formatting-Visible Conditional Text is used to
store the converted character entities.
[599]

Prefix the ‘search for’ string with ‘%’ to search for a field
starting with the specified text (.e.g ‘findme%’)
Suffix the ‘search for’ string with ‘%’ to search for a field
end with the specified text (.e.g ‘%findme’)
[625]

• Serial number entered by user is now cleaned-up before
validation by stripping invalid characters or replacing
characters commonly confused characters.
[583]

• An optional fourth parameter has been added to
‘XREFFIELD’ custom field function to allow a data source
name to be specified. This allows field content from
another data source to referenced. When using this
custom field, ‘Synchronize with Data Source’ will also
synchronize data sources referenced by this command.

[626]

• Added new option has been added to ‘Adopt Fields’
to specify whether new records should be marked as
‘Inserted’ or ‘Deleted’ in the panel.
[586]
• Added
regular

support
for
the
expression

\U

operator
on
back-references.

REGEX(FIELDSTR(field a),'^(...)(...)(..)','\L\1-\U\2-\U\3')



• ‘GROUPLIST’ custom field function now has an optional
last parameter which specifies whether only unique
values are returned (default) or whether all values should
be returned.
[634]

[620]

• If ‘Flag Empty Pictures as Errors’ is set the replacement
image will be imported for empty picture fields; if it is not
set the replacement image will not be imported.
[621]

• New
custom
field
command
‘GOOGLEQRCODEURL’ which will call
the Google Charts API to generate a
QR code with the given content. This
function call can be used in the Picture
Options on the Field Options dialog.

• The HTML parser has been improved so that if an HTML
entity cannot be found in the current font, alternative
fonts will be searched for the glyph.
[638]

• More characters have been added to the ‘Ignore White
Space changes’ list. “Page Number” and “Index Marker”
characters which have been inserted should now be
ignored.
[639]
• The ‘Edit Field Content’ dialog is now bigger.

GOOGLEQRCODEURL(500,500,'Hello')

[672]
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• A new continuation type of ‘Grow and Flow’ has been
added. This item will be used when the text box has
been extended to the bottom of the page and it needs to
continue on the following page.
[600]

• During guide-based pagination, if there’s a custom field
called ‘paginationFirstOnPage’ it will be populated with
‘yes’ when paginating the first item on the page. This can
be referenced in Pagination Rules Actions.
[628]
• A new option has been added to the ‘Paginate’ dialog
to specify whether the Pagination operation should be
undo-able. Turning this off should significantly improve
responsiveness after pagination completes.
[635]
• Modification
label
to

to
enable

the
data

‘matrixtable’
to
be

script
filtered.

<filter field="fieldname" value="value"/>

The Google Charts API has a maximum width and height
specification of 500 pixels.
[651]

This should be included in the <fields> or <columns>
node.
[635]

• New custom field command ‘URLENCODE’ which will
URL-encode the given string. This function should be
used when building URLs, when importing images for
example.

• ‘matrixtable’ script label now supports header columns at
the right of the table which will remain fixed.
<matrixtable headercolumnsonright="2"/>





[652]

• New custom field command ‘URLDECODE’ which will
URL-decode
the
given
string.

• New option added to the ‘Using Master Pages’ pagination
type to specify the grouping level in the panel to paginate
at. For example, it’s now possible to paginate specific
groups into each position on the page/spread.
[630]

URLDECODE(FIELDSTR('myfield'))



[604]

• When determining whether Product Styles fit on the page,
guide-based pagination should be a little less precise.
Previously it would be determined that an item wouldn’t
fit if it was a fraction of a point over.
[630]

URLENCODE(FIELDSTR('myfield'))

[653]

• New custom field command ‘NOT’ which will return the
boolean opposite of what was passed in.
NOT(IF(LENGTH(FIELDSTR('myfield')),'<',10))



[660]

EasyCatalog Scripting Module

• Added support for UPC-A barcodes which can be
generated using the CarolinaBarUPC font.
[582]

• Add new method to data view object to show a
list of specific records by passing an array of keys:

• New custom field command ‘DECTOFRAC’ which will
attempt to transform a decimal value into a fraction - e.g.
0.25 = 1/4.

var myKeys = new Array();
myKeys[0] = "300-001";
myKeys[1] = "300-002";
myKeys[2] = "300-003";
myDV.showRecords(myKeys);

DECTOFRAC(FIELDSTR(field a))



[642]



• Added new custom field command ‘SNIPPETDEPTH’.
This function will populate the given snippet with the
contents of each record and return the depth of it in
points.

[592]

• The ‘fieldContent’ property is no-longer read-only and
can be modified using scripting.
[617]

• A new scripting call has been added to save the local
data snapshot to the workspace folder. This should
be called, for example, after modifying field content.

This function will be useful for instances where it may
be requried to calculate how many records can fit on a
page, for example. For performance reasons turn off
the ‘Automatically Update Content’ option on the Custom
Field Field Options pane.

myDS.save();



[619]

• A new scripting call has been added to ensure custom
field content is up-to-date.

SNIPPETDEPTH("Macintosh HD:My Snippet.idms")

myDS.updateCustomFields();

• Perfomance improvement when evaluating custom fields.
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EasyCatalog Pagination Module

The following bugs have been fixed in this release of EasyCatalog. For clarity, the bug reports listed below show the original
problem as reported. It is often not possible to detail the fix for each issue as they involve internal changes to EasyCatalog.

EasyCatalog

• Too many nodes were created in the reports XML which
could lead to crashing.
[611]

• EAN8 check digit is not always calculated correctly when
using the ‘EAN8’ custom field function.
[579]

• In Field Options, if the replacement parameter for a
cleansing option contained a custom field function, the
‘seach-for’ argument for the cleansing option would be
inserted into the output string instead of the result of the
function.
[658]

• Crash attempting to validate an image path that contains
double colons (‘::’). This affects Macintosh CS4 only.

[581]
• If a field is set to ‘Imported Text’ from ‘Field Content’, the
content is only being inserted when a new field is inserted
into the document and not during drag ‘n’ drop.
[587]

• Table cell merging does not always ignore hidden
characters which therefore prevents the table cell from
merging.
[659]

• Update Panel is not updating picture paths in the panel.

[599]
• ‘Cell Finder’ and ‘Auto Pickup’ crash intermittently.
• Table columns do not always merge vertically.

• When data panels are docked but hidden, they will not
synchronize with the front-most document when shown
for the first time.
[671]

[607]
[580]

• Horizontal table population sometimes crashes.

• ‘Imported Text’ not showing as ‘in error’ if the file cannot
be loaded.
[588]
• Empty fields that are set as ‘Imported Text from Field
Content’ are showing as ‘in error’ after placement. [589]

EasyCatalog FIle Data Provider

• No parse errors are being displayed. 

• LEFTSTR and RIGHTSTR commands fail if the length
given is greater than the length of the field.
[596]

• No error is being reported for corrupt UTF-8 files. 

• Some of the panel icons are missing when running under
InCopy.
[602]

[669]

[641]
[640]

EasyCatalog ODBC Data Provider

• ‘Show Subset’ not working for fields that are set as
‘Imported Text’. The wrong set of operators are displayed
in the ‘Show Subset’ dialog.
[623]

• Temporary fix which should prevent crashing when using
the Actual SQL Server ODBC driver. 
[645]

• ‘Synchronize with Data Source’ is slow when the structure
of the file changes.
[624]

EasyCatalog Pagination Module

• Potential crash when using \L and \U back-reference
operators.
[636]

• Frame fitting does not resize the box deep enough when
‘First Baseline’ text frame setting is applied. 
[644]

• Page hyperlinks sometimes produce invalid hyperlinks.

[637]

• The fitting option ‘Frame Depth to Field Depth’ should be
performed before the content of the box is resized.  [594]

• Automatic key generation not working on Windows.
Holding Shift and Alt when pressing ‘OK’ on the File
and ODBC Data Source configuration dialogs will add a
custom field and automatically generate a key for each
record. This should be used with extreme caution,
however, as it may not be possible to later update data
placed using this generated key.
[662]

• The ‘Continuation’ pagination type is not working with
Grow and Flow pagination.
[600]
• Box fitting functions will sometimes move the box.

[584]

• ‘Unhandled exception in ECAutoPageInserter.cpp at line
240’.
[593]

• Guide-based pagination placing Product Style at wrong
location on page when document has a slug area. [631]

• All configurations on the ‘Configurations’ menu sometimes
have check mark against them. Only the configurations
applied to the panel should be checked.
[657]

• Memory leak when populating tables horizontally.

[650]

• The fitting option ‘Frame Depth to Content Depth’
sometimes affects the width of the box.
[654]

• Table column resizes too small when it contains formatted
text. This occurs when using the ‘Fit to Content’ column
option.
[664]

• Incorrect library item being chosen during pagination.
If the library contains a wildcard item (‘*’), this may be
chosen even though there may be an item with a name
that matches the nominated field.
[590]

• Table column resizes too small when it has a stroke
applied. This occurs when using the ‘Fit to Content’
column option.
[665]

• ‘Field not found’ error when using Pagination Rules
Actions on a Relational data source group that has no
records.
[608]

• ‘Update Panel with Page Numbers’ is slow when using
‘Collate pages for all grouped records’.
[666]
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• The wildcard library item may not be chosen for group
items when using the ‘Asset Name’ pagination option.

[609]

• ‘Remove Blank Lines for Empty Fields’ not working if
there’s an empty anchored picture box.
[615]

• A guide placed on the page edge is not being detected by
guide-based pagination.
[629]
• Text-on-a-path items sometimes disappear.

[670]

EasyCatalog Scripting Module

• Updating the page numbers via the script call is not
saving the local data snapshot in the workspace folder.

[612]

• ‘applyConfiguration’ call does not always work. If
the name of the data source view is not the same as
the data source, applyConfiguration will fail to find the
configuration to apply.
[633]
• ‘dataView.selectedRecords()’ is returning a view that
cannot access its records.
[632]
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Enhancements
EasyCatalog

• When searching in the Record Viewer panel, the
highlighted search result is now horizontally scrolled into
view.
[501]

• A new option is available on the right-click contextual
menu: ‘Clear Update Flags’. This new option will remove
the ‘updated’ status from the selected record(s).
[469]

• Added ‘Key Fields’ search option to the Record Viewer
panel to allow the user to search the content of only the
key fields.
[504]

• 512 fields can now be displayed on the Field Specifiers,
Field Options and Show/Hide Fields menus.
[470]
• A new keyboard shortcut has been added - ‘Replace
Fields In Selection’ which will show the EasyCatalog
‘Replace’ dialog but only replace the fields in the
document selection.
[498]
• Added support for the <SMALL> HTML tag.

Custom Field Functions

• Support has been added for the EanT48L barcode font.
The EAN13/EAN8 custom field functions have been
modified to accept an optional second parameter which
specifies the glyphs to use:

[503]

• Added new contextual menu option to allow field content
to be edited within EasyCatalog. Right-click on the field
to edit and select ‘Edit Field Content’
[512]

EAN13(FIELDSTR(code), GETBARCODEGLYPHS('EanT48L'))
[483]

• Added ‘COUNTOF’ custom field function which returns
the number of instances of one string in another.

• When using the ‘Adopt Fields’ menu option, any records
that are present in the document but not in the data source
being adopted to can now be added to the panel. Any
records added to the panel will be shown as ‘deleted’.

COUNTOF('Apple', 'p')
[484]

• When using regular expressions, the contents of back
references can now be converted to lower case by
prefixing the back reference with \L:

[516]

• Fields that have been updated in the data source are now
shown with a yellow dotted outline when the background
colour of the field is red.
[536]

• The EasyCatalog workspace folder can now be organized
into sub-folders. These sub folders are now displayed in
the ‘File → New → EasyCatalog Panel’ menu.
[538]

REGEX:(.+?<small>)(.+?)(</small>)=\1\L\2\3;
[488]

• Added ‘INDEXOF’ custom field function which returns the
character index of one field within another.

• If the structure of a data source changes, EasyCatalog
will now show the differences between the old and the
new. Previous versions would load a fresh copy of the
data and not highlight the changes.
[540]

INDEXOF(FIELDSTR('Manufacturer'), 'Apple')
		

[492]

• Added ‘LENGTH’ custom field function which returns the
length of the given string.

• Added mouse scroll wheel support for the Record Viewer
Panel and the Group dialog.
[542]
• User-interface
elements
of
EasyCatalog
can
now be suppressed (disabled) or hidden using a
‘SuppressedUI.xml’ file in the root of the EasyCatalog
workspace
folder.

LENGTH(FIELDSTR('Body Copy'))
[493]

• Added ‘LASTINDEXOF’ custom field function which
returns the character index of the last instance of one
string within another.

<?xml version=”1.0” encoding=”UTF-16” standalone=”yes”?>
<SuppressedUI>
<SuppressedAction actionID=”576521” restrictionType=”hide”/>
<SuppressedAction actionID=”576565” restrictionType=”hide”/>
</SuppressedUI>

LASTINDEXOF(FIELDSTR('Body Copy'), 'Apple')
[494]

• Added support for InDesign metacharacters in custom
field function parameters.

[xxx]

Record Viewer Panel

INDEXOF(FIELDSTR('Manufacturer'), '^p')

• Added support for literal (exact match) searching in the
Record Viewer panel. Entering the search term in single
quotes will only show records where the entire field
content matches the search term entered.
[499]

		

[495]

• Added ‘XREFFIELD’ custom field function which searches
returns the contents of another record’s fields.
XREFFIELD('PartNbr',FIELDSTR('XrefPartNbr'),'PageNbr')

• Searches are now case insensitive in the Record Viewer
panel, unless a literal search is being performed.
[500]

[531]

• Added ‘GROUPXREFFIELD’ custom field function which
searches returns the contents of another record’s fields
within the same group as the record.
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[546]

• Added ‘GROUPNUMBERSEQUENCE’ custom field
function which creates a comma separated list of numbers
in the specified field in ascending order. Contiguous
ranges are shown as nnn-nnn.

keepmergedcellstogether
[547]

• Right/CTRL click support added to Pagination Rules
panel to set pagination options.

GROUPNUMBERSEQUENCE('Parent Group:Child
Group','TOC _ PageNumber')

• Scroll-wheel support added to Pagination Rules panel.
[555]

• Added ‘GETNTHPOPULATEDPARAM’ custom field
function which returns the n’th populated parameter.

EasyCatalog Scripting Module
Added

GETNTHPOPULATEDPARAM(0,FIELDSTR('
Small _ Price'),FIELDSTR('Medium _
Price'),FIELDSTR('Large _ Price'))

new

‘Remove

Field

Markers’

scripting

call.

var myEasyCatalog = app.easycatalogObject;
var myDoc = app.activeDocument;
myEasyCatalog.removeFieldMarkers(myDoc);

[565]

[312]

• An optional parameter has been added to the LoadFile
call to specify the encoding type.

EasyCatalog Pagination Module

• Specifying a ‘Position Index’ of ‘ALL’ will copy and repeat
the contents of a text box once per record in the group
being paginated.
[548]

var myDS = myEC .loadFile(“my data source”,
“Macintosh HD:utf8file.csv”, “,”, “LF”, “key”,
“UTF8”);

• Added new Frame Fitting option - ‘Frame Content Depth
and Width’ which will adjust the width and height of the
frame to fit the content (in the same manner as double
clicking the bottom-right control point of the text frame).

[513]

• Added an optional parameter to the ‘paginateUsingDefaults’
call to specify the document to use.
[568]

• Added new scripting call to specify field options.
The parameters are: field name, option name, option
value. The option name is the same as specified in the
‘Fields.xml’ file.

[560]

• Added new Pagination Rule - ‘Fitting Anchor Point’ - which
specifies the anchor point to use when frame fitting. For
example, specifying an anchor point of ‘bottom center’
will resize the top of the box down until the text fits. [570]

myDS.setFieldOption(“Make”, “prefix”, “xxxx”);
[514]

• A new pagination option is available (which can currently
only be set via a scripting call or by manipulating
‘Pagination.xml’ in the EasyCatalog workspace folder)
which forces ‘Position Based’ pagination to paginate
the product styles in the position specified (rather than
populating the product style and then moving it to the
specified co-ordinates).
[572]

Bug Fixes
EasyCatalog

• Custom fields that do not have a function specified are
not being formatted (prefix, suffix, etc).
[490]

• Regular expression back references would sometimes
insert the wrong characters.
[472]

• Custom fields that do not have a function specified
cannot be used as a parameter to other custom fields.

• Crash when using group custom field commands with a
field that does not exist.
[474]

[491]

• Picture import would always add the file extension even if
it was already present in the field content.
[475]

• Empty strings should evaluate to ‘0’.

• Empty image fields not importing the replacement
image.
[482]

• Insertion of Field Specifier is losing character styles
applied to the text. This only occurs when text is selected
in the document whilst inserting a field specifier.
[505]

[496]

• Carriage returns, new lines and tabs should be replaced
by spaces when displaying field content in the record
viewer panel.
[502]

• Field definition files from the CS1 version would not
import on Intel Macintoshes.
[478]

• Placed status not updating correctly when dragging a
populated library item or snippet to the document. [489]
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• Columns can now be excluded from the ‘Restrict Vertical
Cell Merging to Page Bounds’ function by highlighting the
table column and specifying the following in the ‘Script
Label’ dialog:

GROUPXREFFIELD('Parent Group:Child Group', 'PartNbr',F
IELDSTR('XrefPartNbr'),'PageNbr')

• Image URLs containing a colon generate an error when
downloading (Macintosh only).
[557]

• “Exclude from Document Updates” and “Exclude from
Data Source Updates” renamed to “Exclude from Update
Document” and “Exclude from Update Panel”.

• Custom field command parser attempts to interpret
string literals which are outside of custom field function
parameters.
[564]

• ‘Occurred’ is spelled incorrectly in the product registration
error messages.
[509]

• Images containing a trademark character will sometimes
fail to import images (Macintosh only).
[563]

• Single quotes inside of string literals for custom field
function parameters are not being un-escaped.
[566]

[510]

• Unable to create a new data source if a data source of
the same name is displayed in the Record Viewer panel.

• Crash when producing a matrix table from Relational
data.
[569]

[515]

• Overset text is not always appearing in red in the panel.

• Column header icons are displayed in the wrong
position.
[517]

[571]

• Insertion of a field is losing the character styles applied
to the text. This only occurs when text is selected in the
document prior to inserting the field.
[518]

• MIN function not working.

EasyCatalog Pagination Module

• ‘Update Document’ is dirtying the document when no
fields have been updated.
[519]

• Pagination crashes if all boxes have been deleted from
the Product Style by actions.
[479]

• File → New → EasyCatalog Library dialog is defaulting
to a location inside of the InDesign application package
(Macintosh only).
[520]

• ‘Prevent Break’ inserts a break character even when the
Product Style has been inserted as the first item on the
page, resulting in an unnecessary blank page.
[480]

• Fields for records marked as deleted should be shown as
‘in error’. Records marked as deleted that contain placed
fields should also appear in advanced query results for
‘error’ records.
[521]

• ‘Use Next Position if Item Doesn’t Fit’ not working when
‘Collision Detection’ is turned off.
[481]
• If an invalid ‘Position Index’ is encountered during
pagination, InDesign will crash.
[487]

• Corrupted path after using folder chooser on Windows
7.
[528]
• Crash when opening some data sources in CS5.

[574]

• The ‘Show/Hide’ action doesn’t work with text boxes.

[522]

[529]

• The ‘Ungroup’ Pagination Rule will sometimes cause
pagination to stop with the error ‘One or more objects
would move off the pasteboard’.
[524]

• Unable to activate the plug-ins if the trial has not
expired.
[530]
• Character styles located in style groups cannot be used
in Formatting Tags.
[532]

• The ‘Ungroup’ Pagination Rule is not always processing all
of the groups (e.g. when a group contains sub groups).

• The colour attribute in the <font> tag does not recognise
colours with spaces in their names when applying
formatted text.
[541]

[525]

• A ‘field not found’ error may occur when evaluating a
Pagination Rules Action when using a Relational Data
Source.
[527]

• Fields in table headers and footers are being shown as ‘in
error’ if they are in a header or footer that is not displayed
due to the ‘skip first’/’skip last’ row attribute.

• ‘Update Furniture’ should ignore the contents of table
header and footer rows.
[544]

[549]

• ‘Update Furniture’ not always sorting the first and last
items on the page correctly.
[554]

• When populating a Product Style, any Field Specifiers/
Fields that are in hidden conditional text will not be
populated.
[550]

• ‘Update Furniture’ sometimes uses the last item on the
previous page instead of the first item on the page. [559]

• Recomposition issue after ‘Restrict Vertical Merging to
Page Bounds’.
[551]

• Fit box to text sometimes leaves the box overset.

[562]

• Position-based pagination will sometimes add blank
pages to the document when inserting new pages. [577]

• Cleansing behaves differently on Mac and Windows
machines. Windows version will sometimes ignore the ^
regular expression character.
[552]

• Position-based pagination should use section page
numbers.
[576]

• Update Page Numbers from book panel is recreating
custom fields after every document - it should be done
once at the end.
[553]

• Progres bar on master-based pagination sometimes
shows too many steps when the panel is grouped. [575]

• Improved error reporting when downloading an image
from a URL.
[556]

EasyCatalog Relational Module

• ‘Unable to access resource’ error when displaying the
Relational configuration dialog for the first time.
[561]
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• Update Furniture using the first item on the page will
sometimes use the last item from the previous page. [506]

25 August, 2010

Enhancements
EasyCatalog

• Regular expressions used in cleansing field option
now support back references:

• Added support for context menu in data panels. User
can now right-click when over a data panel to show a
context-sensitive menu. Macintosh users can also CTRLclick to show the context sensitive menu.

REGEX:^^(..)(....)=\1.\2.;
		

[340]

• Added support for empty filename extensions
when
multiple
extensions
are
specified:
jpg;eps;;
[443]

• A new picture alignment option of ‘None’ has been
added.
[341]

• Discretionary hyphen has been added to the list of
characters that are ignored when ‘Ignore White Space
Changes’ is selected.
[393]
• Additional option added to Field Options → Advanced
to prevent empty picture fields from being shown as
‘in error’.
[434]

• Insert Field Specifier, Field Options and Group all behave
in the same manner as the data panel’s pop-out menu.
• Hide Field: Hides the field from view

• Macintosh only: POSIX paths can now be used to
specify the location of images.
[464]

• New Custom Field: Creates a new field in the panel.
The content of this field can be calculated using a
series of new inbuilt functions.

• New ‘Advanced’ field options have been added to
prevent a field from being updated during the ‘Update
Document’ and ‘Update Panel’ operations.

• Reorder Columns Alphabetically: Reorders the columns
in the panel alphabetically by name,

• Show Image Search Paths: This option will open a
browser-based report showing the paths EasyCatalog
will look to find the image for the selected field.
• Update All ‘...’ Fields in the Panel will update only the
named field in the panel

• Update All ‘...’ Fields In The Document will update only
the named field in the document.

• Fields can now be created in EasyCatalog using the
‘New Custom Field’ option on the right-click menu.
The value of a custom field can either be calculated from
the contents of other fields or used to provide summary
information for groups of records.

• Added tool-tip support to the main data panel. User can
now hover over a field to show a tool-tip containing more
of the field content.
[309]

[390]

• ‘Update Panel→With Page Numbers’ now has a new
option: ‘Collate pages for all grouped records’. This
collects all pages that records appear on for a given
group, collates them into a single value and populates
the nominated field in the entire group.
[363]

• The ‘Record Viewer’ panel will now search the contents of
all fields rather than just the key field value.
[335]

• InDesign’s fitting and alignment options specified through
the ‘Object→Fitting Options’ dialog are now applied when
importing images.
[341]

• Document report now shows picture paths and link
statuses.
[373]

• If picture offset fields have been specified on the Field
Options→Picture Content panel, they will now be updated
as part of the ‘Update Panel’ operation.
[415]

• Added support for self-signed HTTPS certificates.
Currently, all HTTPS certificates will be accepted as
valid, regardless of whether they are self-signed or not.

• New keyboard shortcut for ‘Update Document With Panel
Selection’. This can be specified in InDesign’s keyboard
shortcut editor.
[367]

[394]

• Downloading images from a URL:

• Changes to Field Options:
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• Support has been added to specify proxy server and
HTTP authentication details for downloading images from
a URL. These settings can be found in the application’s
general preferences.
[456]

• Images can now be downloaded from a HTTPS
address
[391]

• ‘Adopt Fields’ is now also available on the book panel
menu.
[442]

• Windows only: Characters that are legal in a URL but
illegal in a Windows filename are now stripped when
caching the file locally.
[379]

• Added ‘Update Panel → With Page Positions’. This will
update the panel with the X and Y positions of fields in
the document. For text fields, the position of the text box
containing the field is used.
[374]

• Added confirmation dialog to the ‘Remove Field Markers’
operation.
[396]

• The cell finder can now work on a document-wide basis
(it no longer requires a document selection).
[347]

• A new row type is now available in Table → Row Options:
rows can now be defined as header rows, footer rows or
rows that are inserted ‘once per group’. The content of
group header rows is now ignored when processing the
column deletion option, so if the column is empty but the
header row contains a value it will be deleted.
[466]

EasyCatalog XML Data Provider

• The first time a field is added to an XML data source, the
user now has the option to automatically add all fields
shown in the ‘Examples’ pop-up.
[292]

• Added new keyboard shortcut ‘Auto fill tables’. This new
function will inspect an InDesign document table and
attempt to populate it with data from the panel.

EasyCatalog Pagination Module

• Guide-based and Flow-based Pagination only:

New option added to the ‘Paginate’ dialog to automatically
include page, frame, column or odd/even breaks when
the contents of a specified field change. 		
[329]

• ‘Update Furniture’ is now an option on the Book panel
pop-out menu.
[343]

• RGB values can now be specified by the field used in the
‘Apply Swatch Named In’ Pagination Rule. The contents
of the named field should be in the form:
#RRGGBB
RR, GG and BB should be the hexadecimal value for the
red, green and blue values.
[356]

In this example, a document table has been pre-filled
by the user with stock codes. Although the remaining
columns are empty, these could also be populated with
data. This data will be updated to the latest values from
the panel after performing the ‘Auto fill tables’ operations.

• Added new action keyword ‘firstingroup’. The {firstingroup
GROUPNAME} action can be used to determine if a
record is the first within a named group. This behaves the
same during both drag and drop and pagination.
[354]

ODBC Data Provider

Added support for user-supplied parameters to the SQL
query that is executed to retrieve the data.

EasyCatalog uses the table column headers to identify
the fields to insert into the table cells. This new function
will either update all tables in the document or only the
selected table cells.

• The field name column in the Record Viewer panel is now
resizable.
[459]
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• All images can now be cached in a single folder per
field. This allows the URL to be changed without
rending all image links on the document invalid. [395]

RELEASE NOTES

➀

➁

Parameters are included in the SQL statement inside of
{{ brackets }}. ➀ The value inside of the brackets is the name
of the parameter presented to the user; ➁ a default value can
also be included.

Parameters can also be changed on the data source
‘Information’ dialog. Once the parameters have been
changed, press the ‘Update’ button to re-execute the SQL
query to retrieve the new data set.

When the query is executed, the user will be prompted for
the value of the parameters in the query:

EasyCatalog Scripting Module

• The ‘Update Page Numbers’ scripting call now has an
optional parameter to specify the name of the field to
search for.
[370]

A maximum of four parameters can be specified in the query.

• New function call added for master-based pagination.

myDV.paginateUsingMasters(myDoc, 1, “spreads”);
Parameter

Description

document

The document to paginate into.

page number

The page number to start paginating at.

spread/
pages

Specifies whether to paginate spreads or pages.

masterfield

(Optional) Specifies the field containing the
name of a master page to apply when starting
pagination on a new page.

breakField

(Optional) When the contents of the specified field
changes, a new page or spread will be started.

• New function call to get the current panel selection:
selectedDataView will return the data view with the
current selection; selectedRecords will return a data
view containing only the selected records.

©2003 - 2013 65bit Software Ltd. All rights reserved.

Visit us at www.65bit.com

36

myDS.updatePageNumbers(myDoc,
“”, false);

var myDV = myEasyCatalog.selectedDataView();

• Added a new script method on the EasyCatalog object
to retrieve details of the selected links. The function
getSelectedLinks returns an array consisting of sets of:
“data source, key field value, field name”.
=

var myEasyCatalog = app.easycatalogObject;
var
myDS
=
myEasyCatalog.datasources.
item(“FMCONS2.CSV”);

myEasyCatalog.

var myDV = myDS.dataviews.item(“FMCONS2.CSV”);
myDV.applyConfiguration(“Indeling”);

		

for (index = 0; index < mySelection.length; index
+= 3)

[449]

• Added a new function, changeKey, to change the
key fields defined for a data source. This function will
not modify document content to reflect the new key
configuration.

{
alert(mySelection[index
+
0]
+
“-”
+ mySelection[index + 1] + “-” +
mySelection[index + 2]);

var myEasyCatalog = app.easycatalogObject;

}

		

[451]

• Added a new function, applyConfiguration, to apply a
configuration by name.

[439]

var
mySelection
getSelectedLinks();

“Field”,

		

var myDVSelected = myDV.selectedRecords();

		

“all”,

var
myDS
=
myEasyCatalog.datasources.
item(“EASYCATALOG TEST”);

[465]

• Updated ‘setPginationOption’ call to support the
new
pagination
settings:
‘FlowBreakOnField’,
‘FlowBreakOnFieldBreakType’,
‘GuideBreakOnField’,
‘GuideBreakOnFieldBreakType’.
[410]

myDS.changeKey(“ArticleIDName”);

		

[448]

• The file parsed by the exchangeTags function can now
use quoted fields.
[437]

• An optional parameter can now be specified on the
upatePageNumbers script call to control if fields with content
are cleared. When this is false, any content in the field will
be preserved. Default is true, which is the previous behavior.

Bug Fixes
EasyCatalog

• Fixes problem where ‘Fit Box to Content’ operations
would not work when an anchored item was aligned to
the bottom of the box.
[368]

• Field-specified column widths were not being applied to
tables that are set to be populated horizontally.
[461]

• Fixes a problem where the selection would sometimes
jump when the user clicks in a table cell.
[467]

• Cell merging now works with horizontally populated
tables.
[371]

• When applying a cell style during table population, if a
paragraph style is specified as part of a cell style it will
now be applied correctly. If a paragraph style is not
specified as part of a Cell Style, any paragraph style
applied to the text in the cell will not be overridden.

• Fixes unknown exception which occurred when
attempting to merge cells in a horizontally populated
table where columns had been deleted due to column
collapsing.
[372]

• Table cell merging now works when anchored images are
placed in the table cells. The path to the anchored image
is used to determine whether cells are equivalent. [375]

[318, 350, 378]

• Added missing error message for when the field specified
by ‘prev’ or ‘next’ keyword could not be found.
[352]

• When populating tables, ‘Copy and Repeat’ now only
copies the contents of the selected cells. To copy the
entire row (as before), select all cells in the row prior to
‘Copy and Repeat’.
[381]

• When not using a shared workspace folder, the ‘Fields.xml’
and ‘Datasource.xml’ configuration files will always be
written to the workspace folder when changes have been
made.
[358]

• Column collapsing now ignores EasyCatalog group
header rows.
[382]

• If a record cannot be found during the field adoption
process, the following characters are stripped from the
beginning and end of the key field value and adoption is
attempted again: Carriage Return, Line Feed, Tab. [365]

• Fixes cosmetic issues in the localized versions.
[384]

• ‘Fit Column to Content’ now also fits the table headers.

• ‘Search for Content’ no longer removes images that have
been imported for a field. ‘Search for Content’ now only
removes and re-imports images that were imported
during a previous ‘Search for Content’ operation.
[366]

[386]

• Fixes ‘unhandled exception in ECProductStyle at line
1042’. This was caused by not having the Pagination
module installed.
[389]
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var myEasyCatalog = app.easycatalogObject;

• Fixed ‘Unhandled Exception in GuideBasedPagination.
cpp at line 360’. This was caused by attempting to
paginate onto a master page.
[355]
• Paginate ‘Group Data’ is now supported for non-relational
data sources. This can be used in conjunction with the
‘Position Index’ attribute to specify which record of a
particular group to use.
[376]

[400]

• If a field is overset within a table cell, EasyCatalog
assumes that it it positioned at the anchor point of the
table. If the table has split across pages, this anchor point
could be on a previous page.
[401]

• During guide-based pagination, items set to ‘Continuation’
are now paginated correctly.
[377]

• Tables contained within field content are no longer
populated. This affected users who were using the
‘imported text’ feature to import text containing a table.

• Error message given by guide-based pagination was
showing the page index number in the document, not the
section page number
[402]

[398]

• When merging using the ‘Restrict Vertical Cell Merging
to Page Bounds’ option, cells are merged progressively
smaller from left to right.
[404]

• When inserting a bulleted/numbered list using the <LI>
tag, an ‘indent to here’ character is now inserted after
the tab to ensure the paragraph is correctly indented if it
splits across lines.
[430]

• Added error message when setting the minimum column
width to zero on the ‘Column Options’ dialog
[405]

• Fixes a problem when loading a panel configuration
that would sometimes prevent it from being applied
immediately. This was a problem where a non-grouped
configuration was loaded into an already-grouped panel.

• Fixes a bug where boxes would be deleted if a postion
index refered to a group, not a record
[407]

• Fixes a problem where group header rows could lose
their content if the first column is deleted as a result of
column collapsing.
[411]

[429]

EasyCatalog Pagination Module

• Fixes cosmetic issues in the German-localized version on
the Pagination dialog.
[345]

• Fixes crash in Master-based pagination when a group
and a box within the group both have position indexes.		

EasyCatalog Scripting Module

[447]

• Minor performance enhancements.

• The function call ‘setPaginationOption’ now works with
boolean values correctly.
[346]

[348]

• ‘Strip Whitespace’ and ‘Remove Blank Lines for Empty
Fields’ operations are now performed after processing
anchored items.
This will prevent blank lines or
whitespace remaining in the document if an anchored
object deletes itself.
[423]

EasyCatalog Relational Module

• Fixed problem when using Left/Right joins. If one of the
tables in a left or right join does not return a match, the
data from a previous record may sometimes be used
instead.
[357]

• Fixes a problem where the progress bar did not always
appear when paginating a small number of library items
with a lot of records.
[351]
• When dragging a single record from an ungrouped
panel to a box that uses the ‘next’ or ‘prev’ keywords in
a Pagination Rules action, an error would be reported
(“an error occurred whilst evaluating a pagination rule
action”).
[351]
• Fixed problems with automatic page insertion:
•

•

•

When the master page consists of multiple single
column text boxes linked together (instead of one
multi-column box) pagination would stop with a ‘the
amount of overmatter was not reduced’ error. [360]
If the first page in the document is even, automatic
page insertion will sometimes stop when the user
is using an ‘odd’ or ‘even’ break. This was caused
by EasyCatalog using the page index number to
determine if an odd or even page had just been
inserted.
[361]
When not paginating at the end of a document,
automatic page insertion would previously fail. [392]
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• Fixes problem when running multiple versions of
EasyCatalog on the same machine and not logged on as
administrator. The serial numbers for one version would
previously be read by the other and marked as ‘invalid.’

September 14, 2009

Enhancements
EasyCatalog

• Deletion of column/row ‘when fields are empty’ checks
the contents of text boxes anchored within the cells. [321]

• EasyCatalog documentation and resources can now be
found on the Help menu.
[175]
• Added an ‘Is Not’ operator to the Subset dialog.

• A ‘DOESNOTCONTAIN’ operator has been added to
Conditional Processing.
[304]

[278]

• Added ‘Is Empty’ and ‘Is Not Empty’ operators to the
Subset dialog.
[325]

• A cancel button has been added to the dialog that
appears warning of the closure of the last panel for a data
source.
[302]

• ‘UPPER’ and ‘LOWER’ are now keywords which can be
used in options such as field suffix, prefix, picture path,
etc.
[283]

EasyCatalog Pagination Module

• Added new pagination rule - ‘Apply Swatch From Field’
- that will apply a colour swatch to the box based on the
contents of one of the fields.
[323]

• A new column option is available to resize the column
based on the amount of content in the column.
[291]

• Added new pagination rule - ‘Apply Object Style From
Field’ - that will apply an object style to the box based on
the contents of one of the fields.
[248]

• The width of a table column can now be set based on the
contents of a field in the data.
[316]
• Added new Pagination Action operands “Is Empty” and
“Is Not Empty”.
[326]

• Library items can now be named ‘*’. When using the
‘Asset Name’ Pagination option, this wildcard library item
will be used when a library item with the correct name can
not be found.
[307]

EasyCatalog Scripting Module

• Scripting operations should now be significantly quicker,
especially when dealing with multiple data sources or
configurations where there are a number of available data
sources.
[306]

• Added support for the ‘color’ attribute on the HTML ‘font’
tag. The colour specified should be the name of a swatch
defined in the document.
[317]

Bug Fixes
EasyCatalog

• ‘Convert to Field Specifiers’ is now highlighted when
text-on-a-path is selected in the document.
[244]

• Fixes crash when attempting to import a text file into a
graphic frame.
[74]

• The formatting tag <P> no longer affects paragraph
alignment (unless specified by the tag itself).
[285]

• During table population, EasyCatalog will no longer
attempt to apply a cell style if the field is empty.
[214]

• Table columns are now deleted before the application of
cell styles.
[215]
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• Guide-based and Position-based pagination now work
correctly when a Product Style deletes itself as the result
of an action
[308]

• Fixes a potential crash when evaluating Pagination Rules
actions.
[310]

• Macintosh only: Fixes problem where image names or
paths containing accented characters would always be
reported as ‘in error’.
[294]

• Update Panel →With Page Numbers now updates records
where fields are included in hidden conditional text. [334]

EasyCatalog Pagination Module

• Fixes problem where images would always be shown as
‘in error’ when placed in non-graphic frames (i.e. if the
content type was not set to ‘Graphic’).
[299]

• Fixes problem where ‘Last on Spread’ furniture option
would not always work with Relational data sources.

• Dragging records to frames that already contain a graphic
should now be easier. Previously the user would need to
drag to white space around the image.
[300]

[287]

• Update Furniture no longer displays an error when
there is no field on the page (or a previous page) in the
document. If there is a furniture box on page 1, but the
first field is on a later page, the furniture box will now be
populated with data for the first field in the document.

• Hyperlinks could previously be applied when the field
type was not set to ‘Hyperlink’. This would occur if the
field had previously been configured as a ‘Hyperlink’.[301]

• Importing field options via the ‘Field Options→Import’
no longer modifies the key field configuration of the data
source being imported into.
[313]

[137]

• Fixes a problem where pagination would stop if the
master frame being paginated into contains text.
[184]

• The picture scale import options now work correctly on
all spreads of the document.
[315]

• Fixes problem where Position Index would always delete
boxes when dragging a single group to the document or
populating a Product Style with a single group.
[328]

• The application of a cell style no longer overrides any
paragraph styles applied to the text within the cell. [318]

EasyCatalog Scripting Module

• The ‘fit to content’ table column options should now be
stored and retrieved correctly.
[319]

• Fixes scripting issue where child data sources of
Relational data sources could not be accessed.
[282]

• InDesign no longer hangs when attempting to resize an
empty multi-column text box.
[320]

EasyCatalog Relational Module

• An error will now be reported if the group name entered
into a ‘Group Name’ attribute is invalid.
[303]

• Fixes memory leak when paginating a Relational data
source.
[298]
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• Fixes bug where a new ‘Fields.xml’ configuration file
would not be written after a ‘Synchronize with Data
Source’ that resulted in the number of fields changes.
This would result in the source data being reloaded each
time the data source was subsequently opened.
[285]

65bit Software Limited was founded in 2003 and specializes in the development of high quality Plug-ins for Adobe InDesign
and InCopy.
We believe that the growing processing power of today’s desktop computers is allowing the development of a new breed of
tools, offering levels of integration, power and ease of use previously only seen in high end publishing systems.
At 65bit we are committed to providing best of breed solutions for the database publishing, catalog, newspaper and
magazine markets.
In addition to developing InDesign Plug-ins, we offer custom development services and can help you to design and
implement an InDesign or InCopy-based solution. You can learn more about our services or submit a request for more
information by sending an email to sales@65bit.com
DAM/System Vendors - Any of our products can be included and branded as part of your solution. Please contact
sales@65bit.com for more information.

Contact Details
Postal:

Meriden House
6 Great Cornbow
Halesowen
West Midlands
B63 3AB

Web:

http://www.65bit.com

Sales:

sales@65bit.com

Support:

support@65bit.com
http://www.65bit.com/support

Twitter:

http://www.twitter.com/65bitsoftware

Feedback:

We welcome all feedback and
bug reports on 65bit products.
Please email any comments to:
support@65bit.com
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